
      Cashbook Complete
Below are the help topics available for Cashbook Complete.    You may need to use the scroll bar to see 
entries not currently visible in the Help window.

Frequently Asked Questions (FAQ)
What is New in Version 4.0
Cashbook
Contact Management
Invoicing
Quotations
Report Writer
Reports
Setup & Administration
Time and Cost

NOTE:-    For this help file, text in Italic is only applicable if you have the relevant module selected.



Cashbook Help Contents

The help topics available for the cashbook are :-

Bank Reconciliation
Bank Statement Importing Rules
BAS Codes - Australia
Bills To Pay
Budgeting
Cash Jobs, Cash Purchase or Journal Entries
Categories
Categories - Australia
Categories - UK, Ireland
Electronic Bank Reconciliation
End of Year Procedure
General Procedure
General Procedure - Australia
Importing a QIF File From Another Program
Importing a Bank Statement From the Internet
Overview
Payments Received
Recalc Button
Reports
Setup
Split Transactions



Cashbook - Overview
General Procedure          Reports          Setup          Split          Bank Rec          End of Year          Recalc          
Delete Old Data

The cashbook has been designed in such a manner that you can easily do your own book work and GST 
returns during the year.      You still need to have your accounts prepared by a qualified accountant at the 
end of the year.    The cashbook reports will give your accountant all the information required to prepare 
your accounts with minimal effort.

With a cashbook the Cash Profit is simply the Total Income less the Total Expenses.    The True profit 
takes into account depreciation, etc. and is calculated by your accountant at the end of the year.

For more information see General Procedure



Cashbook - General Procedure
Overview            Reports          Setup          Split          Bank Rec          End of Year          Recalc          Deleting a 
Line          Inserting a Line          Deleting Old Data          Cash Jobs, Cash Purchases or Journal Entries          
Searching / Sorting          Transfer          Importing a QIF File From Another Program          Electronic Bank 
Reconciliation          Importing a Bank Statement From the Internet

The cashbook module is the financial heart of the program.    Every cheque you write and every deposit 
you make should be entered into the cashbook.    The B (Banked) column should be ticked when the item 
appears on a Bank Statement.

Items shown in Italics are only relevant for Cashbook Complete (All modules).    You can add more 
modules from the setup wizard, or else create a new cashbook with all the modules enabled.

The general procedure for adding transactions to the cashbook is:

1.    Enter the date on which the transaction occurred,    Enter the date you wrote the cheque out or the
date you banked a deposit.    If you enter a double quote (") then the last cheque's date will be copied 
down.

2.    Enter a Reference    You can put a cheque number, customer, or DD for Direct Debit or AP for 
Automatic Payment or VISA or any other reference information in the reference field.    If you enter a 
double quote (") when the line above is a number, then the next reference number will be entered for 
you.

3.    Enter a Category    If the whole transaction falls into one category of income or expense, then choose
the category from the drop down list.      If one transaction is related to two or more categories, projects 
or project items then use a "Split" transaction.    Simply enter "Split" in the category column and the 
split entry form will open so that you can enter multiple categories, projects and project items for each 
transaction.    You can double-click on the category box to bring up the split form for an existing split 
transaction.

4.    Enter Notes    Enter any notes relevant to the transaction.
5.    Enter the transaction amount    Enter the transaction amount either of the income (deposits) column

or the expense (cheque's or payments) column.
6.    Enter the GST percentage for the transaction or leave it at the default rate from the setup.
7.    Enter the Project Details if the transaction is related to a project    Enter the project and project 
Item that the transaction is related to and any additional notes.    Entering project details in the 
cashbook will post values into the actual column of the project costs.

8.    Invoice Details (INV, From, On)    You can select the Invoice here, and mark it off as paid, but it is 
better to do that through the Payments Received screen.    If you want to keep track of the amount of 
money you have paid to various creditors, you can select the creditor in the From box.

The Line Details shown at the bottom of the screen are for the cashbook line that you are on.    Think of 
the Line Details as an extension of the Cashbook Line.

If you need to enter a transaction for an unusual amount of GST (eg. the customs department) then you 
can calculate the GST Rate as GST% = (GrossAmount x 100 / NettAmount) - 100.    If you need to enter a
transaction which is entirely GST (eg. the customs department again) then enter a GST Rate of 100%.    
Because these are non standard GST rates you will probably need to make adjustments on the GST 
return.

After entering a transaction a new blank line will be available for the next entry, and the running total bank
balance will be updated.



Cashbook - General Procedure - Australia
Overview            Reports          Setup          Split          Bank Rec          End of Year          Recalc          Deleting a 
Line          Inserting a Line          Deleting Old Data          Cash Jobs or Cash Purchases          Searching / 
Sorting          Transfer          BAS Codes          Importing a QIF File From Another Program          Electronic 
Bank Reconciliation          Importing a Bank Statement From the Internet

The cashbook module is the financial heart of the program.    Every cheque you write and every deposit 
you make should be entered into the cashbook.    The B (Banked) column should be ticked when the item 
appears on a Bank Statement.

Items shown in Italics are only relevant for Cashbook Complete (All modules).    You can add more 
modules from the setup wizard, or else create a new cashbook with all the modules enabled.

The general procedure for adding transactions to the cashbook is:

1.    Enter the date on which the transaction occurred,    Enter the date you wrote the cheque out or the
date you banked a deposit.    If you enter a double quote (") then the last cheque's date will be copied 
down.

2.    Enter a Reference    You can put a cheque number, customer, or DD for Direct Debit or AP for 
Automatic Payment or VISA or any other reference information in the reference field.    If you enter a 
double quote (") when the line above is a number, then the next reference number will be entered for 
you.

3.    Enter a Category    If the whole transaction falls into one category of income or expense, then choose
the category from the drop down list.      If one transaction is related to two or more categories, projects 
or project items then use a "Split" transaction.    Simply enter "Split" in the category column and the 
split entry form will open so that you can enter multiple categories, projects and project items for each 
transaction.    You can double-click on the category box to bring up the split form for an existing split 
transaction.

4.    Enter Notes    Enter any notes relevant to the transaction.
5.    Enter the transaction amount    Enter the transaction amount either of the income (deposits) column

or the expense (cheque's or payments) column.
6.    Check the BAS Code(s) in the box near the bottom of the screen (the BAS Code(s) shown are for 
the line you are currently on)    See BAS Codes.

7.    Enter the Project Details if the transaction is related to a project    Enter the project and project 
Item that the transaction is related to and any additional notes.    Entering project details in the 
cashbook will post values into the actual column of the project costs.

8.    Invoice Details (INV, From, On) You can select the Invoice here, and mark it off as paid, but it is 
better to do that through the Payments Received screen.    If you want to keep track of the amount of 
money you have paid to various creditors, you can select the creditor in the From box.

The Line Details shown at the bottom of the screen are for the cashbook line that you are on.    Think of 
the Line Details as an extension of the Cashbook Line.

If you need to enter a transaction for an unusual amount of GST (eg. the customs department) then you 
can calculate the GST Rate as GST% = (GrossAmount x 100 / NettAmount) - 100.    If you need to enter a
transaction which is entirely GST (eg. the customs department again) then enter a GST Rate of 100%.    
The GST will be calculated correctly for your BAS return.

After entering a transaction a new blank line will be available for the next entry, and the running total bank
balance will be updated.



BAS Codes

The following information is presented in a simplified form, and is to be used as a guide only.    Please see
your BAS Instructions (NAT3030), your accountant or the ATO for anything you are unsure about.

N/A                    Is for exempt items such as superannuation, wages, work cover, share dividends, 
employment income, insurance payouts, tax paid to ATO, loans received or paid, 
transfers, etc.

INCOME
G1                        Is for all sales income which has GST (from products, services, or assets).
G1 & G2    Is for export sales (from products, services, or assets).
G1 & G3    Is for the sale of basic food, health services, education services, childcare services, etc.
G1 & G4    Is for input taxed sales such as interest received, rental income from residential premises,

the sale of a house, etc.

EXPENSES
G11                    Is for all general (non-capital) expenses which have GST and have a proper Tax Invoice 

(or are less than $50).
G11 & G13 Is for (non-capital) purchases for making input taxed sales.
G11 & G14 Is for the purchase of basic food, bank fees, interest, purchases from a company who is 

not GST registered, or a company who has not provided a proper Tax Invoice.
G11 & G15 Is for general (non-capital) purchases which are for private use.

ASSETS
G10                    Is for the purchase of a capital item (asset) which has GST and has a proper Tax Invoice.
G10 & G13 Is for capital purchases for making input taxed sales.
G10 & G14 Is for zero rated capital purchases such as a house, etc.
G10 & G15 Is for capital purchases which are for private use.



Cashbook - End of Year Procedure
Reports          Bank Rec          Year 2000          Delete Old Data

At the end of the financial year you need to provide your accountant with the required financial information
for him or her to prepare a set of accounts.

If you use the invoicing module, then the following must be done before any more invoices are entered or 
paid off :-

1.    Finish all your Invoicing for the Last Financial Year    If you have any incomplete invoices then 
complete them or schedule them for the next financial year.    Make sure that all your invoicing for the 
last financial year is complete, and that you don't later on enter any more invoices in that financial year.

2.    Print the Invoices Outstanding Report    Go to the the Invoices Outstanding screen, and print the 
Detail Report.

3.    Print the Bills to Pay Report    Go to the Bills to Pay screen and print the report.

When you receive your next bank statement then :-

1.    Make sure that the Cashbook is up to date    Enter all payments and deposits from your cheque 
and deposit books irrespective of whether they have been listed on your bank statement or not.

2.    Do a Bank Reconciliation. Make sure that the Bank Statement Balance in the Cash Book, and the 
Closing Balance on the Bank Statement are the same.    If not then you need to find the errors and 
correct the cashbook.    Print the Bank Reconciliation

3.    Print the Cash Book Summary    Print the Cash Book - Summary Report using the Start and Finish 
dates of the year in question

4.    Print the Detailed Cashbook Report    Print the cashbook - Detailed Report using the Start and 
Finish dates of the year in question

5.    Print the Transaction Report    Print the cashbook - Transaction Report using the Start and Finish 
dates of the year in question.    The Transaction Report is under the Cashbook menu.

6.    Repeat for each Account    If you have used several bank accounts then repeat steps 1 to 5 for each
bank account.

7.    Enter the Next Year End Date    in the Setup Wizard under the File menu

You should now have the information required for your accountant to prepare your year end accounts.

You may also want to purge the data from the year before last (In the File, Purge menu) and then 
compact the database to speed up the backups.    Before purging, it is recommended that you make a 
backup of your data file, and rename it so that it has the year on the end of it (ie. mydata.cb would 
become mydata 2002.cb).    Store it in a safe place just in case you need to access that year’s data at 
some time in the future.

Cashbook Complete uses open ended accounting, and you should NOT create a new cashbook at the 
start of each year because all your historical data (graphs, budgets, invoices, etc.) will not be in your new 
cashbook.



Cash Book - Reports
Reports - Contents          Balance Sheet          End of Year

Please note, that Cashbook Complete only shows Reconciled transactions in the reports.

Cash Book - Bank Reconciliation
This report lets you do a Bank Reconciliation at the click of a button.    It Lists the Cash Book Balance, 
followed by all the unpresented cheque's and deposits followed by what the Bank Statement Closing 
Balance should be.

Important !!    You should always do a Bank Reconciliation whenever you get a Bank Statement and 
make sure that the Closing Balance as shown on the Bank Statement is the same as the Bank Statement 
Balance as shown in the Cash Book.

Cash Book - Transaction Report
The Cash Book Transaction List is simply a print out of what you see in the Cash Book.    You can also 
make your own Transaction Report with the Report Writer.

Cash Book - Detailed Report
This report lists all the Cash Book Transactions between the dates specified, and groups them by 
Category. You can also make your own Detailed Report (Report by Category) with the Report Writer.

Cash Book - Summary
This report lists the Total for each Category of all the Transactions between the dates specified.

Profit and Loss
This report is similar to the Summary Report, except that it does not show the Balance Sheet categories.

Balance Sheet
This report shows the current state of your company.

Category List
This report lists all the Categories that are defined in the cashbook.    You may want to fax it to your 
accountant before you start using the cashbook.



Cashbook Setup
Setup Wizard          Categories            Deleting a Line          Delete Old Data

For each bank account your business operates you can create a cashbook, which will record all the 
transactions made in that account.      Before using the cashbook, you need to set up the categories, 
account names, and the account Opening Balances as follows :-

1.    Check the Cashbook Categories Select Cashbook from the Top Menu, and then select Categories 
Setup.    Modify the categories to suit your business.

2.    Enter your Account Numbers    Select Cashbook from the Top Menu, and then select Accounts 
Setup.    Then enter your account type and number.    For example if you have a cheque account, a 
savings account and a term deposit account, enter names such as Cheque 060169 0090888 01,    
Savings 060169 0090888 25,    Term Deposit,    etc.

3.    Enter the opening balance    Select a Bank Statement from which you wish to start (preferably the 
start of the financial year), and enter the opening balance.

4.    Enter all the Items from your Bank Statements    Open the cashbook, and enter all the items from 
the first selected Bank Statement.

5.    Do a Bank Rec    Do a Bank Reconciliation after entering each Bank Statement
6.    Repeat 4 and 5    Repeat steps 4 and 5 for all subsequent Bank Statements which have not been 

entered.
7.    Change the Dates    Change the dates for each cheque item in the cash book to be the date on which

the cheque was written rather than the date on which it was presented.    (You can leave this step and 
step 8 out if you wish, but it would mean that you always enter the data from your bank statements, 
rather than from your cheque and deposit books.    Although it is a bit easier,    the disadvantage of this 
method is that you won't know the amount of money which you have on hand.    ie. The Cash Book 
Balance.)

8.    Enter all the Items from your cheque / deposit Books    Enter all the items in your cheque book 
and deposit book which have been made after your last bank statement.

Your cashbook is now set up and ready to use.

By entering your cheque and deposit information from your cheque and deposit books on a regular basis, 
you will always know how much money you have available by looking at your cashbook balance.



Cashbook Categories
Cashbook Setup          Deleting a Category          Balance Sheet Categories

The cashbook categories need to be set up before using the cashbook.    It is important to set up the 
categories in such a manner that they give you useful reports.      The cashbook is initially set up with 
default categories, but you can either :-

1.    Add a new category at the bottom of the list.
2.    Delete an existing category by placing the cursor on it and then selecting Delete Line from the Edit 

menu.
3.    Rename an existing category by simply over-typing it.

Income categories are for your sales / income.    Expenses are for your costs / expenses.    Balance sheet 
items are those items where although there is a transaction of some nature, it does not directly affect your
cash profit (see link at the top of the page).

If you put a category in the Balance Sheet section when it should be in the Expense section or vice versa,
then you can always move it later.    A lot of cash books do not have a Balance Sheet section, so you 
could simply put everything under either the Income or Expense sections.    The cashbook would still 
calculate the GST correctly.

Some accountants may request that you use specific codes for each category so that they can simplify 
the preparation of the year end accounts.    To do that simply prefix each category with the corresponding 
code (eg. 470 Telephone).

If you want to use Sub Categories, you can put a : between the main category and the sub category.    For
example you could enter the categories Motor Vehicle:Joe, Motor Vehicle:Fred, and Motor Vehicle:Mark.   
Most reports will show them seperatley, but the Sub Category Report in the Report Writer, will combine 
these into one category.



Cashbook Categories - UK and Ireland
Cashbook Setup          Deleting a Category          Balance Sheet Categories

The cashbook categories need to be set up before using the cashbook.    It is important to set up the 
categories in such a manner that they give you useful reports.      The cashbook is initially set up with 
default categories, but you can either :-

1.    Add a new category at the bottom of the list.
2.    Delete an existing category by placing the cursor on it and then selecting Delete Line from the Edit 

menu.
3.    Rename an existing category by simply over-typing it.

Income categories are for your sales / income.    Expenses are for your costs / expenses.    Balance sheet 
items are those items where although there is a transaction of some nature, it does not directly affect your
cash profit (see link at the top of the page).

If you put a category in the Balance Sheet section when it should be in the Expense section or vice versa,
then you can always move it later.    A lot of cash books do not have a Balance Sheet section, so you 
could simply put everything under either the Income or Expense sections.    The cashbook would still 
calculate the GST correctly.

Some accountants may request that you use specific codes for each category so that they can simplify 
the preparation of the year end accounts.    To do that simply prefix each category with the corresponding 
code (eg. 470 Telephone).

The Expense and Balance Sheet columns have a tick box labled "Ex" to indicate categories which are 
Exempt from VAT such as wages, PAYE, National Insurance contributions, drawings, loans, gifts, 
charitable donations, insurance claims, MOT certificates, motor vehicle licence duty, and local authority 
rates.    For more information see your accountant or HMCE.

If you want to use Sub Categories, you can put a : between the main category and the sub category.    For
example you could enter the categories Motor Vehicle:Joe, Motor Vehicle:Fred, and Motor Vehicle:Mark.   
Most reports will show them seperatley, but the Sub Category Report in the Report Writer, will combine 
these into one category.



Cashbook Categories - Australia
Cashbook Setup          Deleting a Category          Balance Sheet Categories

The cashbook categories need to be set up before using the cashbook.    It is important to set up the 
categories in such a manner that they give you useful reports, and that they have the correct BAS codes.  
The cashbook is initially set up with default categories, but you can either :-

1.    Add a new category at the bottom of the list.
2.    Delete an existing category by placing the cursor on it and then selecting Delete Line from the Edit 

menu.
3.    Rename an existing category by simply over-typing it.

Income categories are for your sales / income.    Expenses are for your costs / expenses.    Balance sheet 
items are those items where although there is a transaction of some nature, it does not directly affect your
cash profit (see link at the top of the page).

If you put a category in the Balance Sheet section when it should be in the Expense section or vice versa,
then you can always move it later.

Some accountants may request that you use specific codes for each category so that they can simplify 
the preparation of the year end accounts.    To do that simply prefix each category with the corresponding 
code (eg. 470 Telephone).

If you want to use Sub Categories, you can put a : between the main category and the sub category.    For
example you could enter the categories Motor Vehicle:Joe, Motor Vehicle:Fred, and Motor Vehicle:Mark.   
Most reports will show them seperatley, but the Sub Category Report in the Report Writer, will combine 
these into one category.

BAS Code(s)

In the BAS Code(s) column select the most appropriate BAS code(s) for that category.    The BAS codes 
are as shown on the "GST calculation worksheet for BAS" provided by the ATO with your BAS return.

The following information is presented in a simplified form, and is to be used as a guide only.    Please see
your BAS Instructions (NAT3030), your accountant or the ATO for anything you are unsure about.

Income BAS Codes

N/A                    Is for exempt income such as share dividends, employment income, insurance payouts, 
etc.

G1                        Is for all sales income which has GST.
G1 & G2    Is for export sales
G1 & G3    Is for the sale of basic food, health services, education services, childcare services, etc.
G1 & G4    Is for input taxed sales such as rental income from residential premises, bank interest 

received, etc.

Expense BAS Codes

N/A                    Is for exempt expenses such as superannuation, wages, work cover, etc.
G11                    Is for all general (non-capital) expenses which have GST and have a proper Tax Invoice 

(or are less than $50).
G11 & G13 Is for (non-capital) purchases for making input taxed sales.
G11 & G14 Is for the purchase of basic food, bank fees, interest, purchases from a company who is 

not GST registered, or a company who has not provided a proper Tax Invoice.
G11 & G15 Is for general (non-capital) purchases which are for private use.



Balance Sheet BAS Codes

N/A                    Is for exempt items such as drawings, tax paid to the ATO, loans received or paid, 
transfers, etc.

G10                    Is for the purchase of a capital item (asset) which has GST and has a proper Tax Invoice.
G10 & G13 Is for capital purchases for making input taxed sales.
G10 & G14 Is for zero rated capital purchases such as a house, etc.
G10 & G15 Is for capital purchases which are for private use.

Default Values

The BAS codes and GST rates are all default values which will be used in the cashbook.    They can then 
be over-ridden to handle exceptions that sometimes occur.    For example when you sell an asset (capital 
item) then over-ride the BAS Code in the Cashbook from G10 to G1.



Cashbook Categories - Balance sheet Items
Cashbook Categories

Income and Expenses are easy to understand, but balance sheet items are a bit harder.      Balance sheet 
items are those items where although there is a transaction of some nature, it does not directly affect your
cash profit.      For example :-

1.    Transfer    If you transfer money from one bank account to another, that does not affect your cash 
profit.

2.    Assets    If you purchase an asset, the asset will affect your bank balance, but not your cash profit.    
An allowance for depreciation will be made by your accountant at the end of the year.

3.    Drawings    If you take drawings (Salary) out of the company, you are taking some of the profit out of 
the company, but you are not affecting the profit you make.

4.    GST Paid to the Tax Department    You will have been collecting GST on behalf of your 
Country/State.    The GST payments you make to them are therefore not an expense.

5.    Loans    Receiving a loan, helps your cash flow but you don't want to include it with your sales 
(income).

If you put a category in the Balance Sheet section when it should be in the Expense section or vice versa,
then you can always move it later.    A lot of cash books do not have a Balance Sheet section, so you 
could simplify matters by putting everything under either the Income or Expense sections.    The cashbook
would still calculate the GST correctly.



Cashbook - Recalc Button

The "Recalc" button recalculates the bank balances if for some reason the database has been corrupted 
(eg. The power to the computer went off while entering a transaction), or if Dates have been changed, 
etc.



Split Transactions
Deleting a Line

Split transactions are used to show a series of costs as one entry in the cashbook, for example a VISA 
bill. To create a new split transaction, select Split in the category box.    To open an existing Split, either 
double click where it says Split in the Category column, or else click the Split button on the toolbar.    
Please note that the Split button is only enabled when you are on a split, and cannot be used to create a 
split.

Enter each item included in the split transaction ( for example each item on a VISA bill).    When the form 
is closed, only the totals will be shown in the cashbook line. The information for each item in the split 
transaction is still stored separately. To view (zoom into) the details of a split transaction, double click on 
the split category, or click the Split button.

Split Transactions can also be used to split items such as your Motor Vehicle expenses between business
and private.    For example if you allocate 75 % of your motor vehicle use to the business, and you 
purchase $ 40 of petrol, then you could enter a split entry which has $ 30 as a business expense and $ 10
for drawings (Private use).

Please note that when you make a Split, the overall GST Rate is not shown in the main cashbook screen 
(when you close the split), because if you make a split with different GST Rates, a GST Rate of 7.65% in 
the main cashbook screen would look odd, and generated a lot of confusion.    The GST Rates are 
however still included in all the reports.



Reconciling The Cashbook With Bank Statements
Reports          End of Year          Electronic Bank Reconciliation

When you get a bank statement, first check that the opening balance is the same as the current bank 
balance as shown by the cashbook (in the Bank Bal box).

Then simply tick each item on the statement and the cashbook as a pair.    If there is an item such as bank
fees, interest, or an automatic payment on the bank statement which is not in the cashbook, then enter it.  
Check that the amounts are correct as you tick each item.    When you have ticked all the items, the 
cashbook Bank Balance should equal the bank statement closing balance.

Important :- If the balances are not equal, then go through all the items on the bank statement and find 
where the error is.    If you do not find where the error is, then it will progressively get harder and harder to
find where the error is, and you will make life very difficult for yourself or your accountant at the end of the
year.

Important :- Print out the Bank Reconciliation after each bank statement, or if you get several bank 
statements a month, print it out at the end of each month.



Cashbook - Shift Category

If for example you want to change a cashbook category from "Expense" to "Balance Sheet", then with the 
arrow keys move down to the category you want to change, and select "Balance Sheet" from the Combo 
Box.



Payments Received
Deleting a Line

The Payments Received screen enables you to enter all of your bank deposits quickly and easily.    The 
Payments Received are automatically posted into the Cashbook and Invoice Payments (To mark them off 
as Paid).    Although you can enter Payments Received directly into the cashbook if you wish (with the 
same end results), it is easier to enter them through this screen.    If you have a lot of payments, you may 
want to print out the Cheque Listing and attach it to your deposit slip.

To enter payments received :

1.    Select the Appropriate Account    From the Account drop down box, select the correct account for 
which the payments should appear in the cashbook.

2.    Check the Date    Either accept the default date, or override the date by typing in your own date.
3.    Select a Company    From the Company drop down box, choose the company for which the payment 

is from.    If you know the invoice number you can skip this step.
4.    Select an Invoice    (Cashbook Complete only)    The INV drop down box will show you a list of all 

outstanding invoices for the company selected.    Simply select the invoice that you have received 
payment for.    If you have received one cheque for several invoices then enter each invoice on a 
separate line.    They will be recombined in the cheque listing if you use it.

5.    Select a Category    From the category drop down box select the appropriate category for the 
payment.    The category will automatically appear the next time you choose the company currently 
selected.

6.    Enter Bank and Branch    You can enter Bank and Branch details if you need to print out a cheque 
listing.    As with categories, these will also automatically appear next time you choose the company 
currently selected.

7.    Enter Notes    If you wish, you can enter miscellaneous notes into this text box.
8.    Enter the Amount    The amount defaults to the invoices outstanding amount.    It can be overridden 

by typing in your own amount.    If you are paying too much, or too little, Cashbook Complete will ask 
you if you are sure you want to process that amount.

9.    Repeat Steps 2 to 8    Repeat steps 2 to 8 for all your payments received.
10. Print out a cheque listing    If you have lots of cheque's to deposit, you may want to print out the 

cheque's listing to attach to your deposit slip.    On the cheque listing, if there are several consecutive 
lines with the same company name (ie. one cheque for several invoicies), they will be combined into 
one line on the printout.

11. Post to Cashbook    Once you have entered your payments received, simply click on the Post to 
Cashbook button, and all transactions listed will be posted into the cashbook.    The amount 
outstanding for each invoice will be updated, and the status will be changed to Paid if appropriate.    
When the transactions have been posted, the cashbook screen will load.    If more than one payment 
was received, then they will be put into the cashbook as a split transaction.



Bills To Pay - General Procedure
Deleting a Line          Retentions / Part Payments          Split

The Bills To Pay screen lets you keep track of the bills you have to pay, and lets you post them into the 
Cashbook in one easy step.    Although you can enter bills you have paid directly into the cashbook if you 
wish (with the same end results), it is easier to enter them through this screen.

The general procedure for entering a new bill is :

1.    Select the Appropriate Account    From the Account drop down box, select the correct account for 
which the bills should appear in the cashbook.

2.    Enter the Date the Bill is Due    Type in the date in which the bill is due.
3.    Enter the Invoice Date    Type in the invoice date.    The Invoice date is important if you calculate GST 

on an Invoice or Accrual Basis.
4.    Enter the Ref    Enter the Cheque Number into the Ref field.
5.    Enter a Company    From the drop down box, choose the company whom the bill is from.    If the 

company does not exist, then you will be prompted to add the new company.
6.    Select a Category    From the category drop down box select the appropriate category for the bill (This

will be used for the Cashbook later on).    You can make this a Split if you want to.
7.    Enter Notes    If you wish, you can enter miscellaneous notes into this text box.
8.    Enter the Amount Type in the amount you were billed for.

The general procedure for paying bills is :

1.    Print out the Bills To Pay (Optional)    If you need to get someone else to approve the bills to pay then 
you can print it out and give it to that person first.

2.    Write out the Cheque's    For each bill you want to pay, Tick its Pay box, and write out a cheque for it.
3.    Print out the Envelopes (Optional)    Tick the Env box for the bills you want an envelope printed and 

click on the Envelope Print Button.    To print envelopes your printer must have an envelope feeder
4.    Post to the Cashbook    When you have written out all the cheque's and printed out all the envelopes 

you want, press the Post to Cashbook button to transfer these transactions to the Cashbook.

The cashbook balance provides you with a quick check of how much money you have in the bank.

A customisable version of the report is available in the Report Writer.



Bills To Pay - Retentions / Part Payments

If you only want to pay part of a bill because the work is not complete, or is faulty, then simply enter two 
records, one for the amount you want to pay now, and the other for a date in the future with the remaining 
amount.



Bills To Pay - Split

If you want to split a payment between two categories, then enter the split details here.

Split Transactions can be used to split items such as your Motor Vehicle expenses between business and 
private.    For example if you allocate 75 % of your motor vehicle use to the business, and you purchase $ 
40 of petrol, then you could enter a split entry which has $ 30 as a business expense and $ 10 for 
drawings (Private use).



Cash Jobs, Cash Purchases or Journal Entries

Cash Job

If you get paid cash for a job you have done, and you don't bank the money, then simply enter a double 
transaction into the cashbook as shown below :-

The Income and Expense amounts cancel each other out, so the bank balance is not affected.    The 
business received money from a sale and paid it out to you in the form of drawings / salary.    The GST is 
still calculated correctly, and the sale is recorded in the cashbook.    Please Tick the B column for these 
lines, because they have effectively both been banked.

Cash Purchase

If you purchase an item for your company out of your own money, then you can simply enter it as a 
double transaction as shown below :-

The Income and Expense amounts cancel each other out, so the bank balance is not effected.    The GST 
is still calculated correctly, and the purchase is recorded in the cashbook.    To understand this transaction,
remember that it is from the point of view of the business!      The business had a parking expense, and 
paid for it by receiving the money from you.    Please Tick the B column for these lines, because they have
effectively both been banked.

It is not recommended to put these double transactions into a Split Transaction, because the Nett Amount 
in the main part of the cashbook can look rather odd (even though it is right).

Journal Entries

You can make Journal Entries in a similar manner as shown above, or can make a Split in the cashbook.



Cashbook - Importing From Another Program

You can import cashbook data from MS Money, Quicken, or any other program which supports the .QIF 
format.    Some programs do not export QIF files with the proper format in which case your QIF file may 
not import. 

To import the data :-

1.    Export the data to a QIF file from MS Money or Quicken    The import routine accepts either loose QIF 
or strict QIF.

2.    Import the data    Select "Import QIF File From Another Program" from the Cashbook menu.    If GST is
enabled, then check that the GST rate is correct.    Click on the Import button and locate the file.    The 
data will be placed into a new account if it doesn't already exist.

3.    Check the Category Types    Once the data has been imported, please check the categories, and shift 
them to the appropriate type (Income, Expense or Balance Sheet).    You can shift categories by 
selecting Categories Setup from the Cashbook menu, and then select Shift Category.

4.    Check the Category Names    Check that the Category names are correct.    Some of them may have 
been truncated.

5.    Check the Account Details    Check that the Account details are correct (Select Account Setup from 
the Cashbook menu).    You may want to delete the old account first.    (View help from the Accounts 
screen).    You can enter the opening balance and do a full bank rec if you want to.

6.    If your Import was Unsuccesful then Undo It    If your accounts, account balances, etc. do not look 
correct, then revert back to your original data.    Go to the Edit menu, and select Undo (before you exit 
the program).

MS Money and Quicken are trademarks of Microsoft and Intuit respectively.



Importing a Bank Statement
Rules          Electronic Bank Reconciliation

If you have access to your bank account on the internet, you will most probably be able to export your 
bank statement as a QIF file.    You can then import that file into the cashbook, and automatically reconcile
your cashbook.    This feature should not be used by computer novices.

Dates
Please note, that with "Electronic Bank Reconciliation", the date for each line is changed to the bank 
statement date when it is reconciled.    Suppose for example that you write out a cheque on the 8th May, 
and enter it into the cashbook.    If the cheque is presented on the 15th May, then when the Bank 
Statement is imported, the date is changed from the 8th May to the 15th May, and the Banked column is 
ticked.

Frequency
The most common practise is to import your bank statement(s) once a month (say the first working day of 
every month), but you can do it as often as you want.

To import the Bank Statement :-

1.    Determine the Start Date    The start date is as follows :-
For Your First Import    If you pay GST to the Tax Department, your first import should not include 
any transactions in a GST period for which your have already submitted a GST Return.    For 
example, if you have paid GST for July, then start importing transactions from the 1st August.    All 
transactions before the 1st August will not be altered, but all transactions from 1st August onwards, 
will have the dates changed so that they match up with the bank statement date.
For Subsequent Imports    Imported Bank Statements should always overlap with the previous 
import.    For example, if for your last import you imported data from the 1st May to the 25th May, 
then for your next import, get transactions starting from the 25th May or earlier.

2.    Save your Bank Statement as a QIF File    Go to your banks web site, log on with your account name 
and password, and export your bank statement to a QIF file.    Save it in the "C:\My Documents" folder,
and make a note of the file name you saved it as.    If you can select several different date formats, 
then choose the one which is correct for your country.    If you have the choice of four digit or two digit 
years, then four digit years are better.    If you have options for 'MS Money', 'Quicken', 'MYOB', etc. 
then choose Quicken.    Before exiting your banks web site, write down your Bank Account Balance 
which you will use in Step 4.    If you have difficulty downloading your bank statement, please contact 
your bank for help.

3.    Import the data    Select "Import QIF File Downloaded From Internet" from the Cashbook menu.    
Select the bank account you want to import into.    Click on the Import button and locate the file you 
saved in step 2.

4.    Check the Bank Balance    The "Bank Bal" shown at the bottom right hand side of the cashbook 
screen should now equal the Account Balance shown on your banks web site.    If they are not the 
same it could be because :-

a)    the cashbook was not reconciled properly before the import.    You need to manually reconcile 
the cashbook.    You can Undo the import if you wish (See step 5).

b)    the Opening Balance for that account is not correct.    Suppose for example that the cashbook 
Bank Bal is $12.45 too high, then deduct $12.45 from the Opening Balance (See Bank Account 
Setup under the Cashbook menu), and the Bank Bal should now be correct.

c)    there was a gap in the data (ie. you didn't overlap the imports).
d)    for the first import the merge was not correct.    When importing for the first time into an account

with existing reconciled transactions it is possible for there to be duplicate transactions because 
of the differing transaction dates.    Some extra checking may need to be done for the first 
import.

5.    If your Import was Not Successful then Undo It    If for any reason you are not happy with the import, 
then you can Undo it.    Go to the Edit menu and select Undo (before you exit the program).



6.    Assign the <Unassigned> Categories    After the import you will see a lot of <Unassigned> categories. 
Assign them to the correct category.    If you have a repetative transaction, then it is a good idea to 
make a Rule for it, so that it remembers the category you want to use, next time you do an import.    
The easiest way to make a new rule, is to click on the line in the cashbook that you want to make a 
rule for, click Rules, click New and edit the rule.

7.    Clean up the Notes    Imported lines usually have a whole lot of junk in the Notes field which you can 
edit or delete if you want to.



Bank Statement Importing Rules - Lookup
Rules          Electronic Bank Reconciliation

When you import a Bank Statement, the Importing Rules can be used to automatically assign the 
Category and Notes to repetitive transactions.    The Lookup screen shows rules for either :-

1.    All    This shows all the rules.
2.    For Current Transaction    If the cashbook is open when you open this screen, then the rules(s) that 

match the current transaction is shown.
3.    Suggested    Cashbook Complete keeps a record of repetitive transactions, and what they are 

assigned to, and if there is a pattern, it suggests a new rule.    To make a suggested transaction into an
actual rule, click on the rule, and then click on Make Rule.

Lookup - brings up a screen with the rule, so that you can view or edit it.
Update Now - updates the cashbook with all the rules (only <Unassigned> items are updated).
Options - shows extra importing options
New - Makes a new rule.    If you are on a transaction in the cashbook, the rule will be based on the 
current transaction.
Delete - Deletes the selected rule.



Bank Statement Importing Rule
Import Bank Statement          Electronic Bank Reconciliation

When you import a Bank Statement, the Importing Rules can be used to automatically assign the 
Category and Notes to repetitive transactions.    The top section shows the criteria for the rule, the next 
section shows what will be done if the criteria are met, and the last section shows a summary of the rule 
in plain english.

The rules are only applied to <Unassigned> items in the cashbook.

The easiest way to make a new rule, is to click on the line in the cashbook that you want to make a rule 
for, click Rules, click New and edit the rule.

Criteria - (Top Section)

In making a rule make it as strict as possible (so long as it still works in all cases).    For example if the Ref
is always AP, the expense amount is always $54.67, and the Notes are always "033101 033101" then use
all of those in the criteria.    Or, if the Notes are always "Bank Fees", but the amount varies, then only have
the Notes in the criteria.

Most rules use the Notes field, with possibly one other field (Ref, Income or Expense).

Wild Cards for Notes

The asterisk ( * ) wildcard character matches any number of characters.    For example "wh*" will match 
"what", "white", and "why".

Suppose for example that you want a rule that will match the following values of Notes :-

MERCHNT STMT 0000237743 BNZMERCHANTS
MERCHNT STMT 0000270066 BNZMERCHANTS
MERCHNT STMT 0000238456 BNZMERCHANTS
MERCHNT STMT 0000232443 BNZMERCHANTS

You would set the criteria to be Notes = MERCHNT STMT * BNZMERCHANTS

Action - (Middle Section)

Here you specify the action to be taken when the criteria above has been met.    You must specify the new
Category, and can optionally specify the new Notes.

You can make the Category a Split, where the amount is split on a percentage basis between two 
categories.    For example, if you can claim 70% of your telephone bill for business, then make the 
Category = Split, Category 1 = Telephone (70%), and Category 2 = Drawings Other (30%).

If you tick the Retain Notes box, then the notes will not be updated by the rule.

Summary - (End Section)

In the summary, you can read the rule in plain english to make sure that it will do what you expect it to do.

Update Now Button

Pressing this button will apply the current rule to the cashbook, and will let you know how many changes 
there will be.    If you find that the rule was too general, and changed a whole lot of transactions which it 



should not have changed, then select Undo from the Edit menu (before you exit the cashbook).



Import Rules - Options
Import Bank Statement          Rules

QIF files often have a lot of superfluous text.    You can filter that information out by setting parameters in 
this screen.

Replace Multiple Consecutive Spaces with One Space - This gets rid of a lot of unnecessary blank 
spaces.    For example "EFTPOS                    UFS DISPENSARY NELSON" will get replaced with 
"EFTPOS UFS DISPENSARY NELSON"

Convert to Lower Case - This converts all the Notes text to lower case.    The above line would then 
become "eftpos ufs dispensary nelson".

Search For / And Replace With - QIF Files often have junk in the Notes, which we can better do without, 
so here you can filter it out.    By default the "Search For" field has "Part=", " Code=" and " Ref=" 
with blanks for the "And Replace With".    Using these defaults "Part=PARADISE Code=2568664 
Ref=ACCLAIM"    would become "PARADISE 2568664 ACCLAIM".



Electronic Bank Reconciliation
Import Bank Statement          Rules

You can save a huge amount of time with Electronic Bank Reconciliation, by importing your bank 
statements from the internet.    Where the manual reconciliation of a months worth of transactions can 
take about an hour, doing it with Electronic Bank Reconciliation can take a few minutes.    After getting the 
first import reconciled, all subsequent imports are like magic.    The cashbook will merge your existing 
transactions with the ones being imported and will then reconcile the transactions for each day.    You can 
set up rules to automatically assign repetitive or pre-coded transactions to certain categories.

Reconciling Against Manually Entered Transactions
All bills that you pay with the "Bills To Pay" screen, all deposits (bankings) that you do with the "Payments 
Received" screen and all manually entered transactions entered into the cashbook will automatically be 
reconciled with the bank when you import the bank statement.    If you have set up rules to handle the 
repetitive transactions then there should only be a few <Unassigned> transactions which you need to 
assign to the appropriate category.

Precoding Your Cheques
If you don't want to use the "Bills to Pay" screen, you can use pre-coded cheques and rules to 
automatically assign the correct category during the import.    Filling out the analysis code when you write 
out the cheque saves a lot of time later on.    To use pre-coded cheques :-

1.    Make Up Your Analysis Codes - Print out the Categories Report (see Categories Setup under the 
Cashbook menu), and write the code you want to use next to each category.    The analysis code must 
be numeric and is typically three digits.    Then cut the paper down to a much smaller size and put it in 
with your cheque book for quick reference.

2.    Order Cheque Books With Analysis Codes - The cheque books will have an area to enter an analysis 
code like this .    Make sure that you get the one with empty boxes, not one which is filled in 
with sequential numbers.    There may be an extra charge from the bank to use analysis codes, but the
time saved is well worth the effort.

3.    Use the Analysis Codes - Neatly enter the Analysis Code every time you write out a cheque.    Enter 
the leading zero's as shown in the example.

4.    Set up the Rules - It is best to set up the rules after your first import.    The bank will typically add even
more leading zero's.    The above code could for example become 000000000471.    Click on the 
transaction in the cashbook, click on Rules, and New, and then make the rule so that any transaction 
with *000000000471* is assigned to the category Telephone for example.    The * (star) is important 
because it means that anything can be before the number and anything can be after the number.    
Once you have set up the rule then all future imports will assign the appropriate category 
automatically.



Budgeting

You can set up income and expense budgets for each month, to track your progress through the year.    
For your convenience the actuals are shown in yellow below the budgets.

The easiest way to set up your budgets is to start off by printing out last years actuals (click on left arrow 
to go to previous year) and then decide what you want to aim for.    You can either enter each monthly 
budget, or if it is the same for each month, you can enter the annual amount into the total column.

The Recalc button recalculates all the actuals from the cashbook data.



Budgeting Setup

Here you can select the bank accounts you want to include in the calculation of the budget actuals.

For example, you might not want to include your Term Deposit account in the calculation of the actuals, in 
which case you would set it to No.



Transfer

To show a transfer of money from one bank account to another bank account, simply enter the amount to 
be transfered as in expense in the one bank account and as an income in the other one.    Use the 
category called Transfer.



Inserting a Line

To insert a line into the cashbook, simply type it in at the end with the correct date.    Next time you enter 
the cashbook, the lines will be sorted into date order.    You can push the Recalc button to resort on 
demand.



Audit Trail

The Transaction Report (under the Cashbook menu) is the Audit Trail in Cashbook Complete.



Balance Sheet

This report shows the current state of your company.    To make the report meaningfull, you need to add 
the assets and liabilities for your company.    Assets would include items such cars, buildings, computers, 
office furniture, etc.    You wouldn't normailly include intangible assets such as Good Will, and the value of 
Intellectual Property.    Liabilities would include items such as loans received (the nett amount you 
currently owe), money you owe to the Tax Department, etc.

Equity is used as the Balancing Item to make the Total Assets and Total Liabilities the same.



Quotations Help Contents

The help topics available for Quotations are :-

General Procedure
Overview
Word Processors
Editing the Default.rtf Template



Quotations - Overview
General Procedure          Report Writer          Word Processors          Delete          Delete a Line          Add          
Delete Old Data

The Quotations module lets you make professional quotes quickly.    If you have entered your products 
and services, then you can quickly enter the clients name, enter the quantities and other items into the 
Calculation Sheet, open the word processor, and hey presto, you have the basic framework of your letter 
done for you too.    You can change the basic framework by editing the Default.rtf file.



Quotations - General Procedure
Overview          Report Writer          Word Processors            Delete          Delete a Line          Add          Delete Old
Data          Editing the Default.rtf Template          Email

1.    Select the Client from the List    Open a New quotation screen, and select a client from the list.    If 
the client has not been entered yet then enter the clients details first.    You can change the address for
this quotation if you wish.

2.    Enter a Description for the Quotation    Enter a meaningful description.    It will be used in many 
places such as lookups, reports and your letter.

3.    Enter the Quote By and Quote For Items    These will be used in the letter and for future reference.
4.    Select the Columns for the Calculation Sheet    Click on the  button and select the columns you 

want.    You can customise your calculation sheet layout to display columns for Discounts, Product 
Codes, etc.    Try selecting different options and watch how the layout changes.    If you want to save a 
particular configuration for future quotes, click on Set As Default.

5.    Enter the Items in the Calculation Sheet    These items will determine the value of the quote and will
show you the Margin (Profit) of the job.    You can use the small binoculars  to select a product or 
service or employees time if you have already set these up.
6.    Select the Type of Word Processor    Select whether you want to use Word or Wordpad (A free but 

cut down version of MS Word) from the toolbar.    Quotes are formatted a lot better if you use MS Word
because you can have tables.

7.    Edit the Default Text    Click on the  button and edit the default text.    This Word document is like a
template or framework that will be used for all new quotes.    You can enter your logo, standard terms, 
etc.

8.    Open the Word Processor    Click on the  to make a new quote document with Word (or 
Wordpad) using the template you made in step 7.
9.    Edit the Quotation Document and Print it    Edit the document and print it as required.
10. Save the Document    When you exit the Word Processor be sure to save it.

Please note that if you change the quote in the cashbook, then you also need to change it in the word 
processor and vice versa.

You can edit the quote document by clicking on the  again.    

If you are using Wordpad, make sure Wordpad is closed before regenerating the document.    If you don’t 
close Wordpad it won’t show any new changes to the document.



Quotations - Word Processors
Editing the Default.rtf Template

It is strongly recommended to use Microsoft Word to edit your Quote documents.    If you don't have Word,
then Windows comes pre-installed with Wordpad which is a cut down version of Word.    Wordpad cannot 
show tables or graphics which makes it's use quite limited.    There are other free word processors such 
as Sun Office, but they have not been tested with Cashbook Complete.



Quotations - Editing the Default.rtf Template

The Default.rtf file is a template or framework for all new quotes, and is used to make (or regenerate) all 
new quotes.    However, to do this requires a bit of PC knowledge, if you are not familiar with editing 
documents, or opening files, you may need an experienced compuer user to help you.

Simply click on the  button and you will see Word (or Wordpad) come up with a document which has a
number of "Tags".    These tags are used to tell Cashbook Complete where to insert the data when 
generating quote documents.    The tags are replaced with the real data from the Quotes screen.

Tags

The following is a list of tags (and their meanings) which you can insert into the default.rtf file.

Tag Meaning
<CompanyName> The company name that has been selected on the quote.
<PostalAddress> The postal address of the company that you are sending the quote to.
<Description> The description of the quote (if you entered one)
<QuoteDate> The date the quote was issued.
<QuoteNumber> Quote number.
<QuoteBy> Staff person issuing the quote.
<QuoteFor> Customer contact requiring quote.
<Details> The entire quote details section.
<SubTotal> The sub total for the quotation.
<Tax> The GST rate.
<TaxAmount> The GST amount.
<TotalAmount> The total amount for the quote
<Salutation> Same as <QuoteFor>, but will use Sir/Madam if Quote for is not used in the quote.

For example, where you see <CompanyName>, Cashbook Complete will insert the clients company 
name.

Letterhead
If you have inserted an image into the cashbook "Letterhead Setup" screen, then you can copy and paste 
it into your Default.rtf file, so that it looks the same (or similar).    This can only be done with Word.    It is 
probably best to create a table with two columns at the top of the document, and put your company logo 
in the left hand column, and your contact details in the right hand column.



Time and Cost Help Contents

The help topics available for Time and Cost are :-

Employees
Import
Products / Services
Projects / Jobs
Stock Received
Stock Take
Timesheets and Expenses



Projects / Jobs
Timesheets          Expenses          Delete          Delete a Line          Add          Creating an Invoice from 
Timesheets and Expenses

If you have a project / job for which you want to track the costs and income, then you can set one up here.
If for a new project, you select the quote for that project, then a lot of the initial setup will be done for you.

Budgets
You can set up a budget for a project, and then allocate costs against those budgets as the project 
progresses.

Actual Values
The Actual values are calculated from the Time Sheets, Expenses and Cash Book screens.    You can see
how the actual cost is made up by clicking on the Magnifying glass for that item.

Income Received
The Income Received is calculated from the Cash Book screens when you allocate a income against a 
project.

Recalc Button
You can press the Recalc button to recalculate the Actual Values and Income Received.    This should not 
normally be necessary but has been included just in case the database gets corrupted.    (For example if 
the power goes off while you are entering data)

Reports
There are two standard types of report available, but you can configure your own reports using the Report
Writer.



Employees
Timesheets          Expenses          Contacts

This page records your employee information.    If you want to set up different access rights for different 
employees and the security check boxes and logon fields are disabled then you must select security in 
the Setup Wizard first.

The Wage Rate is optional, and is there to keep a record of what their wage rate is.

The Cost Rate is normally the Wage Rate plus about 20 % to 30 %.    This is to take into account the fact 
that they also have paid holidays and non chargeable time.    The Cost Rate is used together with the time
sheet information to calculate project costs.

The Charge Rate is the amount that you charge your customers.    It is used in the invoicing module to 
create invoices from time sheets.

If you don't use Time and a Half, or Double Time rate then leave them blank.

All other fields are optional.



Time Sheets and Expenses
Employees          Projects / Jobs          Deleting a Line          Deleting Old Data          Importing Timesheets and 
Expenses into an Invoice

Time Sheets Screen

1.    Keep track of the Hours which your employees have worked    You can keep track of your 
employees time and make reports on their times using the Report Writer.

2.    Keep track of your Project Expenses    You can allocate time against various project items to 
determine the project costs, and can also make reports on the time spent on each project using the 
Projects Detailed Report or the Report Writer.

3.    Allow easy Invoicing if you do a Project on an Hourly Rate    If you do some work on an hourly 
rate, then you can import those times into an invoice for that customer.    For those items to be invoiced
be sure to set the Invoice column to "Yes - To be Invoiced".    After the invoice has been generated, the 
Invoiced column will read "Done - Has Been Invoiced".

Hourly Rates Stored
When you enter a Time Sheet item, the employees current (cost) hourly rates are stored as well for that 
line item.    This is to make sure that the calculations for old data does not change when you change the 
employees hourly rate.    You can view and edit the hourly rates if you have the "Time and Cost" privileges
by scrolling to the right.

Expense Screen

1.    Keep track of the your Employees Expenses    You can keep track of your employees expenses.
2.    Keep track of your Project Expenses    You can allocate expenses against various project items to 

determine the project costs, and can also make reports on the expenses for each project using the 
Projects Detailed Report or the Report Writer.

3.    Allow easy Invoicing if you do a Project on a Hourly Rate Plus Expenses Basis    If you do some 
work on an hourly rate plus expenses, then you can import those times into an invoice for that 
customer.    For those items to be invoiced be sure to set the Invoice column to "Yes - To be Invoiced".  
After the invoice has been generated, the Invoiced column will read "Done - Has Been Invoiced".



Products / Services
Quotations          Invoicing          Deleting a Line

This screen lets you configure your Products and Services, and see a summary of your sales history.    
Use the horizontal scroll bar to see more fields on the right hand side.    All the fields except for the last 
four, can be edited.    The fields are as follows :-

1.    Group    If you want to group your products and services, you can add a group name here.    If you are
entering lots of items with the same group name, then enter that group name in the default field at the 
top of the screen.    If you don't want to use groups then leave this field blank.

2.    Code    This is the Product / Service code. If you don't want to use product codes then leave this field 
blank.    The sales history in the last 4 columns is only calculated for items with a code.

3.    Description    This is a description of the item and is a compulsory field.
4.    Units    Enter the units for the product or service.    Eg.    Hours, kms, miles, m, m², m³, Sheets, Box, 

Box 20, Box 50.    If you enter m2 or m3 the units will change to m² or m³.
5.    Cost Price    This is the price you purchase the goods for, or the cost of the services to you.    The 

sales tax setup screen in the setup wizard specifies whether the prices include or exclude GST.
6.    Sell Price    This is the price you sell the product or service for.    The sales tax setup screen in the 

setup wizard specifies whether the prices include or exclude GST.
7.    Type    There are 4 types.    "Inventory" means a product for which you want to keep track of stock 

levels. "Non Inventory" means a product for which you do not want to keep track of stock levels (ie. 
only want to know the pricing information).    If you have upgraded from an older version of Cashbook 
Complete the Type is set to "-" which means "Unassigned".    Please change these to the corrrect type.

8.    On Hand    This is the quantity you have in stock at the moment, and is only available for products 
(not services).

9.    On Order    This is the quantity you have on order.    When you order product, enter the quantity you 
ordered in this field.    When you receive the product, you can use the Stock Received screen to add to
the On Hand value, and subtract from the On Order value.

10. Min Level    This is the minimum quantity that you want the stock to get down to.    You will be notified 
that you have gone below the minimum when you sell (invoice) it and "On Hand" + "On Order" is less 
than "Min Level".    You can also print the "Products to Re-Order" report (see Report Writer, 
Products/Services).

11. Supplier    This is the supplier of the product / service.
12. Notes    Enter any further notes about the product such as the supplier, quantity on order, etc.
13. Sales YTD    This is the sales of this item for the Year To Date.    The sales tax setup screen in the 

setup wizard specifies whether the prices include or exclude GST.
14. Qty YTD    This is the sales quantity (in units) of the item for the Year To Date.
15. Sales LYR    This is the sales of this item for Last Year.    The sales tax setup screen in the setup 

wizard specifies whether the prices include or exclude GST.
16. Qty LYR    This is the sales quantity (in units) of the item for Last Year.

This screen is sorted by group and then by code.    You can change the sort order by clicking on the field 
you want to sort, and then selecting Sort A-Z from the Edit menu.

New products or services are always added at the end.    The next time you open this screen, the records 
will be sorted.



Stock Take
Report Writer

Simply print out the Inventory Report in the Report Writer, and write the actuals next to the theoretical 
amount On Hand.    When you have finished, adjust the values in the Products an Services screen.    If 
you want to do a blind stock take, then remove the On Hand column before printing the report out.



Importing Products and Services
Deleting a Line

The basic idea of this screen is to copy and paste all the data from your other program into the import 
screen, and then press the Import button.    You do not have to have data in all the columns.

Before importing bulk data, you may want to do a test import with only one line of data.

The general procedure for importing Products and Services is as follows :-

1.    Prepare your Data    If your data is not in a windows program where you can copy and paste columns
of data (such as Microsoft Excel), then you need to get it into one of those programs first.

2.    Copy the Product Description Data    From your spreadsheet, select the column containing the 
product description (by clicking on the button/box at the top of the column - see example below), and 
copy it to the clip board (from the Edit menu).

3.    Paste the Product Description Data    On the Import screen, click on the Description button/box in at
the top of the top of the screen (See example below), and paste the column in (paste from the Edit 
menu).

4.    Copy and Paste the Other Columns    Copy and Paste the other columns in a similar manner to 
steps 2 and 3.

5.    Check and modify the data    Check the data, and modify it accordingly.
6.    Ready to Import    Once all the data has been checked, click on the Import button to import your data.

Selecting a column



Stock Received

When you receive stock, you can easily update the stock "On Hand" and "On Order" values using this 
screen.    Simply enter the product code or description, and the quantity.    When you "Post To Products", 
then the quantity will be added to the "On Hand" and deducted from the "On Order" values.



REPORT WRITER Help Contents

The help topics available for the Report Writer are :-

General Procedure
Formatting Columns
Headers / Grouping
Spreadsheets
Where Conditions
Wizard



Report Writer - General Procedure
Formatting Columns          Headers          Spreadsheets          Deleting a Line          Inserting a Line          Page 
Setup          Where Conditions

The Report Writer lets you configure your own reports and save the templates for future use.

Each row in the report writer screen sets up a column in the report.

The General Procedure for making your report are as follows :-

1.    Give your Report a Name   .      This name will printed at the top of the report, and will be used to 
store the report template for future use

2.    Select the Fields you want to display in the order in which you want them to appear across the
page.    Put fields which you want as headers first.

3.    Select the Fields to be displayed as a Heading    If you want fields to be displayed as a 
heading or sub heading then Check the "Header" Check Box for that field.

4.    Preview the Report to check that the layout is as you want it, and make alterations to the 
Widths and Alignment.

5.    Page Setup Press the "Page Setup" button to set up the Margins and select either Landscape 
or Portrait to orient your Pages.

6.    Select Totals (Sum) for numeric fields if you want them to have Totals at the end of the report 
or Group.

7.    Select Sorting for the fields that you want sorted.    You can either sort Ascending or 
Descending.

8.    Select the WHERE Conditions if you only want to display information that meets certain 
criteria.    You can select =, >, >=, Like, Between, etc.      With the "Like" keyword, you can do 
comparisons with wild cards such as * and ?.    For example Like Acc* will select Acclaim,    
Accent,    Accroplolis, etc.    With the "Between" keyword, you can select a range between two 
values.    This is most commonly used for dates. More info here

9.    Preview the Report and make alterations as required



Report Writer - Formatting Columns

Column Widths

The Column Widths are adjusted by altering the Width Box next to the field selected.    The width is 
roughly the number of characters that will be displayed.    It is not the actual number of characters 
because different characters have different widths.

Column Alignment

Each column can be either Left, Center or Right aligned.    Text is usually left aligned, numbers are usually
right aligned, and Dates are usually center aligned.

Inserting a Blank Column to make a Gap

To insert a Blank Column Select <Blank> from the fields list and adjust width of the Gap

Hiding a Column

To hide a column simply make set it's width to zero.    This may be when for example you want to have the
report meet certain criteria, but don't want to display the information.



Report Writer - Headers / Grouping

In a report you can have headings and group items together.    If you want to use one level of headers / 
grouping then it must be on the first field.    If you want two levels of headings / grouping then it must be 
on the first two fields.    You can have sub totals at the end of a group if you select Sum for that field.



Reports Writer - Spreadsheets

      You can display the report data in a simple spreadsheet layout by clicking on this Spreadsheet 
button.

To copy the data into Excel click on the grey square on the top left hand part of the spreadsheet.    This 
will select all the data in the spreadsheet.    Then press CTRL C.    This will copy the data onto the 
clipboard.    Then open Excel and press CRTL V to paste the clipboard onto the spreadsheet.



Report Writer - Deleting a Line

    Click on this icon to delete a line in the Report Writer



Report Writer - Inserting a Line

    Click on this icon to insert a line in the Report Writer



Report Writer - Page Setup

      Click on this icon to adjust the margins, paper size, etc.



Report Writer - Where Conditions

There are many different operators that can be used to filter your data. Each one is explained below.

Blank

Having a blank where condition means that nothing will be filtered. All information for that column will be 
displayed.

=

The equals operator means show all records that are exactly equal to the criteria entered. The following 
example would display all contacts whose name is exactly equal to Nuku Productions. Note that the 
equals operator is case sensitive, ie. if you specified Nuku Productions as the criteria, then Nuku 
Productions would not be found.

 

>

This is the greater than operator. It filters records that are greater than the criteria entered. The example 
below would display all selling price amounts which are greater than five.

<

The less than operator works the opposite way. It filters all records that are less than the criteria entered. 
The following example would display all selling price amounts which are less than five.

>=

The greater than or equal to operator shows all records that are greater than, or equal to the criteria 
entered. The example below would display all selling price amounts which are greater than, or equal to 
five.

<=

The less than or equal to operator shows all records that are less than, or equal to the criteria entered. 
The following example would display all selling price amounts which are less than, or equal to five.

<>

This is the does not equals operator. It shows all records that do not equal the criteria entered. The 
example below would display all contacts that are not called Nuku Productions (case sensitive).

Like



The like operator searches for values that are like the criteria you specify. The like operator is not case 
sensitive. Using a wildcard (*) will find a range of values (eg. sm* would search for contacts whose name 
begins with sm, sM, Ms, or SM). The following example would display all contacts whose name begins 
with nuku.

Between

The between operator shows all records that are between the criteria entered. The example below would 
display all records that have a date between 1/1/98 and 31/1/98.



Report Writer Wizard - Report Name

The report writer wizard lets you set up a report as easily as possible.    It is easier than the normal report 
writer, but once you have used the wizard a few times you will probably be able to create reports quicker 
with the normal report writer.

Each report is saved so that it can be re-used at a later date.    Please enter a report name which will help 
you look it up again at a later date.



Report Writer Wizard - Data Source

Please select where you want the data to come from.

Some items have different levels of detail.    For example, Projects has three levels of detail.    The first 
level gives just the basic information about each project, the second level lists the costs for each job cost 
category, and the third level lists each item in each job cost category.



Report Writer Wizard - Grouping / Headings

Please select the level of grouping required.

Click on the Radio Buttons to select your choice.    The picture below the Radio Buttons will show you the 
layout you will get for each level of grouping.

If you are not sure, then start off with no grouping.



Report Writer Wizard - Column Headings

Please select the data you want displayed in each column of the report.

If you have selected Grouping, then please select the data to display for the Group Headings first.    After 
seeing the choices, you may want to change the level of grouping by clicking on the Back button.

When you select an item, then sample data is inserted so that you can see whether you are on the right 
track or not.    Please note that the sample data is to give you an indication only of what the final report will
contain.



Report Writer Wizard - Complete

There is no help for this screen.



Invoicing Help Contents

The help topics available for Invoicing are :-

Advance Payments
Back Orders
Bad Debts
Batch Invoicing
Batch Statements
Bounced Cheques
Column Options
Credit Notes / Adjustment Notes
Editing / Deleting a Printed Invoice
Editing / Deleting Payments
Emailing Invoices and Statements
Footer Text
General Procedure
Overpayments
Overview
Outstanding
Payments
Payments Received
Setup Letterhead
Setup Wizard
Statements



Invoicing - Overview
General Procedure          Payments          Delete / Edit          Delete a Line          Add          Credit Notes          
Delete Old DataBatch Invoicing

The Invoicing part lets you Bill your clients with three different invoice styles.

You can import your data for the invoice from a Quote, or from the Time and Cost Module.

All new Invoices have a default Terms message which can be edited if required.

You can enter Notes which will be printed at the bottom of the Invoice if you wish.

You can enter part payments, or full payments in the payments panel.    A report can be printed of all the 
invoices outstanding.

The Invoices have three different states.    They are    :-

"Incomplete" when you create a new Invoice
"Outstanding" after you have printed or emailed the Invoice
"Paid" when you have been paid (to within a dollar)

Only "Incomplete" Invoices can be edited.    Only "Outstanding" Invoices can have an entry made in the 
Paid Panel.    If you have made a mistake, you can Click on the "Pencil Eraser" icon to move the status 
back a step.



Invoicing - General Procedure
Overview          Payments          Delete a Line          Add          Credit Notes and Bad Debts          Delete Old 
Data          Editing / Deleting a Printed Invoice          Editing / Deleting Payments          Batch Invoicing          
Invoice Column Options          Back Orders          Emailing

1.    Select the Client from the List    Select a client from the list.    If the client has not been entered yet 
then you will be prompted if you want to add them to the list.    You can change the address for this 
invoice if you wish.

2.    Select the Invoice Column Options you want for this Invoice    Click on the  button and select 
the columns you want.    You can customise your invoicing layout to display columns for Discounts, 
Product Codes, etc.    Try selecting different options and watch how the invoice layout changes.

3.    Enter the Clients Order Number    if they have one
4.    Enter who or what the work was done for    You can enter several lines of data here if you wish by 

zooming in
5.    Enter the descriptions and amounts for each line item    If you have entered products and services

and / or employee hourly rates then you can select them with the 
6.    Page Setup    To alter the page setup for Invoice printouts, select Print Setup from the File menu.
7.    Print or Email the Invoice    If today's date is different to the Invoice Date, you will be asked if you 

want to change the Invoice date.    The status will change to Outstanding.    If you want to change the 
Status to Outstanding without printing the invoice, then select Print from the File menu, and then click 
Cancel.

8.    Envelopes    Invoices and Statements are designed to work with window envelopes to save you time. 
You may need to adjust your letterhead setup to position the address correctly in the window.    If you 
do not want to use window envelopes, you can print out a normal envelope.

You can enter notes or miscellaneous information about a job by typing in a new line, and then deleting 
the Quantity, Units and Price information.

Importing a “Quote” or “Timesheets and Expenses” into an Invoice

If you have already done a quote for the client, then you can import that quote to make a new invoice, or if
you are doing a job on an hourly rate plus expenses, then import the Timesheets and Expenses from a 
particular client.



Invoicing - Payments
Deleting a Line          Payments Received          Editing / Deleting Payments

There are three ways of paying an invoice off :-

1.    In the Payments Received screen    This screen lets you enter payments for many invoices in one 
data entry screen, and is the recommended way of entering payments you have received.

2.    In the Cashbook    Make a new transaction (or a Split if you want several deposits to appear in one 
transaction) and enter the Invoice Number in the Line Details at the bottom of the screen.

3.    In the Invoice    Simply enter the date and amount of each payment a client makes against an Invoice
in the Payments section of the invoice.    If you do not enter a date then today's date will automatically 
be entered by default.    If you double-click in the amount column of a new payment record then the 
software will automatically insert the outstanding amount and today's date.



Invoicing - Deleting and Editing
Delete Old Data

Editing
Only "Incomplete" Invoices can be edited    If you have made a mistake, you can click on the "Pencil 
Eraser" to move the status back a step    (Admin privilege required).    You can then edit it.

Deleting
Only "Incomplete" Invoices can be deleted with the X ! button.    If you want to delete an "Outstanding" 
Invoice, then click on the "Pencil Eraser" to move the status back a step (Admin privilege required).    You 
can then delete it.



Invoicing - Editing / Deleting a Payment
Delete a Line

Invoice payments are usually linked to the cashbook, so any corrections to these payments need to be 
made in the cashbook.    Simply look at the date and the amount of the payment, and find the 
corresponding transaction in the cashbook.    The transaction may be in a Split.    Check that the invoice 
number is the same, and then make the changes you want to make as follows :-

Deleting
To delete the invoice payment, you can either delete the whole transaction from the cashbook (see Delete
a Line above), or remove the link to the invoice payment (see below).

Editing
To modify the amount of the payment, you need to first remove the link to the invoice (see below), change
the Invoice amount, and then add the link to the invoice back in again.

Removing a Link from the Cashbook to an Invoice Payment
First click anywhere on the relevant transaction in the cashbook.    In the Line Details at the bottom of the 
screen, check that the invoice number in the INV box is the correct invoice number.    Delete the invoice 
number from the INV box.

Editing / Deleting if not linked to cashbook
If the invoice status is Paid, then first click on the Pencil Eraser button to rewind the status of the invoice 
back to Outstanding.    You can then modify the amount, or date, or can delete the whole payment (see 
Delete a Line above).



Credit Notes / Adjustment Notes

If you accidentally over-invoice a client, or they return something and want a credit for it, or have a bad 
debt, then you can issue a Credit Note (or Adjustment Note in Australia).

A Credit Note is made by making an Invoice with negative "Quantities" or "Unit Prices" on the Invoice so 
that the invoice amount is negative.    Please note that negative amounts are shown on brackets.    If the 
amount of credit is inclusive of GST, then you might want to alter the Column Options so that 'Line Item 
Prices Include GST'.

When you print it, you will be asked the invoice number to which it relates, and a credit will be made 
against that invoice.    A Credit Note will be printed instead of an Invoice.



Letter Head

You can customise your letterhead by selecting Letterhead Setup from the Invoicing menu.    The 
letterhead setup screen has five objects which you can customize.    They are :-

1.    Company    Displays your company's name.    You can edit it where it is displayed.
2.    Graphic    Displays your company's logo.    You can Insert your own logo
3.    Address    Displays your company's Address, Phone, etc.    It can edit it where it is displayed.
4.    Line    Displays a line.    You can adjust the thickness (height) and the distance from the top.
5.    Header    This is the headers overall size (ie. The height of the area to set aside for the letterhead).

The company name, company logo (graphic) and address can be moved around on the letterhead, and 
can also have their size adjusted.

A small preview of the header is shown at the top of the screen.    This preview does not show the page 
margins, and light grey borders are shown around the objects so that you can see where they are.    To 
see the real preview, click on the Preview button.

If you have your own letterhead which you want to use, you can make all the objects invisible, and adjust 
the Header Height to suit your letterhead.



Inserting Your Company's Logo

Inserting your logo is simply a cut and paste from Microsoft Paint, but often needs some preparation, and 
needs to be done by someone with reasonably good computer skills.

To insert your logo, you need to make a bitmap (.BMP) file with your logo in it first.    You can create 
a .BMP file either by :-

1.    Converting from another format    If you have your logo on disk then ask your graphics designer to 
save it as a .BMP file.

2.    Scanning it in    Your logo can be scanned in from your letterhead.    This can often be done by 
Printing / Photocopying centres if you do not have a scanner.

3.    From Word etc.    If you have it as an object in Word or some other program, then try cutting and 
pasting it into Microsoft Paint, and then save it.

4.    From the Screen    If you can display it on the screen, but cannot cut and paste it into Microsoft Paint,
then display it on the screen, press "Alt Print Scrn" (to place a copy of the screen on the clip board), 
open Microsoft Paint, and select File Paste from the menu.    You should now see a copy of the entire 
screen you saved earlier on.    Now select the little rectangle on the toolbar, and select only the logo 
with the rectangle.    Press "Ctrl C" to place the logo on the clip board, select "File New" and paste it 
back on again.    When you have finished save the file.

The final .BMP file needs to have enough resolution to print out neatly, but should also not be too large, 
because printing will slow down, and backups will become unnecessarily large.    Typically the .BMP file 
would be 256 colours and around 100k to 300k in size.    Avoid using a BMP file over 300k because the 
database would take longer to backup.

After you have created your .BMP file, Open it with Microsoft Paint, select "File, Select All", and then "File,
Copy".    Then click on the existing logo in the Letterhead setup screen (it should become highlighted) and
press "Ctrl V" to paste it in.    Your logo should now appear instead of the old one.    You can resize it and 
position it to suit.

It is possible to cut and paste the logo from all sorts of applications, but it is strongly recommended that 
you only cut and paste from Microsoft Paint.    Cutting and pasting from other applications has caused 
intermittent problems, and also takes a lot longer to print, because it relies on that application to do the 
printing.



Statements
Batch Statements          Emailing

To print out a statement for a particular customer, select that customer, and then click print or preview.

To email a statement for a particular customer, select that customer, and then click Email.

Please note that "Incomplete" invoices are not shown on a Statement.

Enabling the "Print payments made" box will print any part payments made for invoices, and will include 
all payments made in the last 35 days (ie. last month plus a few days grace).

Enabling the "Print payment slip as footer" will add a payment slip to the bottom of the statement.

You can adjust the Statement Date shown on the statements. (For example to show the last day of the 
month).

To alter the page setup for Statement printouts, select Print Setup from the File menu.



Batch Statements
Statements

If you want to send a statement to all your customers who have an amount outstanding, then enter 0 in 
the "Days Old" box.

If you want to only send statements to accounts which are more than a certain number of days old then 
enter that number in the "Days Old" box and print them out.

You can adjust the Statement Date shown on the statements. (For example to show the last day of the 
month).

Enabling the "Print payments made" box will print any part payments made for invoices, and will include 
all payments made in the last 35 days (ie. last month plus a few days grace).

Enabling the "Print payment slip" will add a payment slip to the bottom of the statement.

To alter the page setup for Statement printouts, select Print Setup from the File menu. 



Batch Invoicing
Invoicing          Emailing

If you need to regularly invoice customers for subscriptions, monthly payments etc. then you should use 
Batch Invoicing.

Before using Batch Invoicing you must set up one or more initial invoices. After you have done this you 
may create a Batch - this is a group of invoices that you wish to repeat and regularly process together.

To Create a Batch:-
1.    Select an invoice that you wish to include in the Batch.
2.    Alter the description if you wish.
3.    Choose the print option required.    Here you can specify whether the invoices should be created as 

incomplete or outstanding and whether the invoices need to be printed.    Note: If you need to make 
additions or alterations to invoices before printing them choose Make Status Incomplete.

4.    Assign a batch number. All invoices with the same batch number will be processed together as one 
Batch.

To Process a Batch:-
1.    Select the Batch to Process.
2.    Specify the Invoice Date.
3.    Click on Process Batch.
This will create a new invoice based on each invoice in the Batch with the Invoice Date specified.
Please note that when the batch is processed the invoices created will become the templates for the next 
batch.



Invoice Column Options

If you are viewing these invoice options from an invoice then you will see the changes to the layout of the 
invoicing screen straight away.    To do this go into an invoice and click on the "Invoice Column Options" 
button.

The "Set As Default" button saves the current settings for new invoices created in the future.

1.    Display the Product Lookup Button    Displays a lookup button (Binoculars) on the left hand side of 
the details section.    You can click on it to find a particular product or service to invoice.    If you don't 
use product codes, or there are too many to remember, but you do want to be able to look them up, 
then turn this on.

2.    Display / Print the Codes Column    Displays a column which lets you select a product or service 
from a list.    If you can remember your product codes, then this lets you enter them very quickly by 
simply typing them in.

3.    Number of Lines for the Description    Each line item in the invoice normally only has one line for 
the description, but if you need more room for the description then you can increase the number of 
lines to display on the screen.    The invoice printout will always expand to display all the information 
typed in the description regardless of the number of lines displayed on the screen.

4.    Display the Cost Centre Column    If you need to allocate different items on an invoice to different 
cost centers, then check this item.    You can then create a report which calculates the sales by cost 
center.

5.    Display / Print the Quantity Column    This can be turned on or off depending on whether you want 
quantities displayed or not.

6.    Allow Formulas in Quantity Column    Some businesses need to enter quantities as formulas.    For 
example a pane of glass 1.234 X 0.456 can be entered in the quantity column, and m² can be entered 
in the units column, and $15 (the cost per square meter of glass) can be entered in the Unit Price 
column.

7.    Display / Print the Units Column    If you want to display units such as Hours, Kms, m², etc, then 
turn this on.

8.    Display the Cost Price Column    If you want to calculate the profit for each invoice then turn this on. 
You can create profit reports with the report writer.

9.    Display / Print the Discount Column    If you want to give your customer a discount then you can 
turn this on.

10. Line Item Prices Include GST    Some businesses want their invoices to show prices which are 
inclusive of GST.    To do that, turn this on.

11. Display GST Rate for Each Line    Some invoices have line items where some have GST and some 
don't.    If the GST rate is not the same for all items on the invoice, then select this option.



Invoices Outstanding

This screen lists all outstanding invoices with the oldest one at the top.    Incomplete invoices are not 
shown.

You can type notes into the Follow Up Notes box to help you chase up that invoice.    You can double click
on it to make it bigger.

To sort by Company (ie. group all invoices for a company together) simply click anywhere in the Company
column, and then select Sort A-Z from the Edit menu.

The Detail Report prints out a report which is similar to the screen.    The Summary Report prints out an 
Aged Debtors report, where each company is only listed once.    A customisable version of the detailed 
report is available in the Report Writer.



Footer Text

The footer text is printed at the bottom of a Invoice, Statement, or Packing Slip.    You can put promotional 
information in the footer text or legal terms such as :-

Ownership of these goods do not pass to the purchaser until payment is made in full.

Please keep these invoices as proof of purchase for warranty purposes.

A late payment fee of 5% per month is applied to over due payments.



Back Orders

There is no way in Cashbook Complete of tracking Back Orders (items you can't deliver because they 
are out of stock).    The recommended way of handeling back orders, is to create an invoice for the 
items you can deliver, print it out (with the packing slip if you want to).    Then create another invoice for
the items on back order, and leave it as an incomplete invoice, until you have enough stock.



Emailing Invoices, Statements and Quotes
Email Setup

Invoices and Statements

There are two ways of emailing Invoices and Statements to your customers :-

1.    Currently Connected to Internet - This is the recommended way of sending emails.    If you connect 
to the internet with a dial-up modem, then dial up and connect to the internet.    You can then send an 
Email Invoice or Statement by simply clicking on the Email button.

2.    Not Currently Connected to Internet - If you click on Email in the Invoice or Statement screen when
you are not connected to the internet, then you will get an error message to say that the email could 
not be sent.    By ignoring the error message, you can queue up up several emails, and send them all 
in one go by later connecting to the internet, and selecting "Send Unsent Emails" from the Invoicing 
menu.

Please note that an Invoice is only "Legal Tender" (ie. approved by the Tax Department) when it is on 
paper, so your customer must print it out.    You can put a note to that effect in the "Invoice Email Footer 
Text" (see Email Setup under the Invoicing menu).    Statements are only a reminder, and are fine whether
they are printed or not.

Returned Email

If the email address is invalid, or no longer exists, you will get it returned to your email box with one of the 
following messages "Undelivered, Undeliverable, Failure Notice, Returned Mail, Mail Rejected, Returned 
To Sender, etc."    Please contact your customer, correct their email address and send the email again.

Email Succesfully Sent, But Nothing Received

If you send an email (and don't get any error messages) but the other person does not receive it, then 
please check the following :-
1.    that their email address is correct (see the Contacts screen).    Get them to spell it out over the phone,

or email you their details.
2.    that your return email address (ie. your own email address) is correct (see Email Setup).    It seems to 

be that mail servers check the validity of the return email address before passing it on.
3.    that you don't have a firewall (internet security program) or virus checking software which is interfering

with the sending of the email.    It has been reported that even Norton Antivirus software can interfere 
with the sending of emails.

Emails do very occasionally get delayed or lost in cyber-space.

Quotes

To email a Quote to your customer, you need to use your email software (such as Outlook) to email the 
quote to the customer as an attachment (use the paperclip icon in the email program).    The quotes are 
stored in C:\Cashbook\Letters\<Company Name>.



Over Payments
Credit / Adjustment Notes

Small Over Payments

Suppose that you invoice a customer for $1,000.00 but they pay you $1,000.07.    A small over payment 
will be handled automatically by Cashbook Complete.    When you enter the payment the invoice will be 
marked of as paid, and the extra 7    cents will 'not' be marked as being a credit.    You will only confuse 
your customer if you tell them that you owe them 7    cents.

Over Payments

Suppose that you invoice a customer for $ 1,000.00 but they pay you $1,100.00 for that invoice.    The 
overpayment is more than just a trivial overpayment, and it can be handled in one of the following three 
ways :-

1.    If the customer has another invoice outstanding, then allocate the extra $100 to that invoice, and send
the customer a statement, so that they can see the new adjusted amount that they owe for that 
invoice.

2.    If the customer does not have any invoices outstanding, then they are in credit.    In the Payments 
Received screen enter the $100 over payment, and leave the INV (Invoice Number) column blank.      
Then make a credit (or adjustment) note for that customer for an amount of $100 (ie. make an invoice 
with a negative amount of $100).    Print out the Credit Note and a Statement for that customer and 
send it to them so that they can see that they are in credit.    Next time you make an invoice for that 
customer, you will be prompted to use the credit note as part payment for the new invoice.

3.    Send the customer a refund of the over payment, and make a note of it in the Cashbook Notes.    Use 
the category of Sales for the refund cheque, and make it a negative Income.



Advance Payments
Credit / Adjustment Notes

Make a credit (or adjustment) note for that customer for the credit amount.    Print out the Credit Note and 
a Statement for that customer and send it to them so that they can see that they are in credit.    Next time 
you make an invoice for that customer, you will be prompted to use the credit note as part payment for the
new invoice.



Bad Debts
Credit / Adjustment Notes          Bounced Cheques

If a customer does not pay an invoice (and never will), then you can either delete the invoice
(click on the pencil eraser, and then the big red X), or you can make a a credit (or adjustment) 
note, print it out, and allocate it to the invoice which is not going to be paid.



Bounced Cheques
Bad Debts

A bounced cheque will still appear in the cashbook, and will have a reverse entry later on.    
To handle this situation, go into the cashbook, and to the transaction where the payment 
was made.    If it is in a Split, you will need to find which Split it is in and go to the 
appropriate line.    You will see at the bottom of the screen a field labled INV with the 
appropriate invoice number.    Delete all the characters in the INV box, and press the Enter 
key.    This will make the Invoice unpaid again.    For the Reversal Entry put in the notes field 
that it is a bounced cheque for invoice 1234 (ie. whatever the invoice number is).    Contact 
the customer and ask how they are going to pay you.



Contact Management - Help Contents

The help topics available for Contact Management are :-

Overview
Importing
Mail Merge
People to Call
Reports



Contact Management - Overview
Reports          People to Call          Delete          Delete a Line          Add          Mail Merge

The contacts screen displays contact and employee information for your clients, suppliers and other 
contacts.    It also has contact management capabilities where you can enter a date when you need to call
a person back in the future.

How to Enter in an Individual Person or Couple
The contact management database is set up to enter many people for one company, but you may want to
enter a client with his home address and phone number, without any company information.    To do that, 
enter their Surname and First Name in the Client Field and enter their Name in the First Name / Surname 
fields.    For example you might enter "Smith, John & Mary" in the client field and enter "John Smith" and 
"Mary Smith" in the contacts list.

List
It is common for client databases to have many people who are in the database with whom you seldom 
do business, but whom you don't want to delete.    To cater for this there is a "List" option on the main part 
of the form which allows you to select which clients you want listed on your Phone List and Address List 
reports.

Email
When you email Invoices and Statements to a company, they are sent to this email address.    Double 
clicking on this field will launch your email program.    Note that client must have an email program which 
can display HTML (the language of the internet).    Nearly all modern email programs can display HTML.

Recall Date
If you want a particular person to display on the People to Call screen enter a Recall Date next to their 
name.

Zoom
You can Zoom into either the Main Notes field or the Employees Notes field by double clicking on it.



Contact Management - Reports
Reports Contents

Address List
The Address List Report is under the Contacts menu, and prints a simple address list for all your listed 
clients and suppliers.    You can also make your own Address List using the Report Writer.

Phone List
The Phone List Report is under the Contacts menu, and prints a simple phone list for all your listed clients
and suppliers.    You can also make your own Phone List using the Report Writer.



People to Call
Contact Management Overview

This screen is used to list all the people whom you need to ring today.    The Recall Dates must first be 
entered through the Contacts Screen.    It works by showing all the Contacts who have a Recall Date of 
Today or earlier.

Zoom
The Binoculars button on the left hand side of each record will bring up the Contacts screen for each 
record.

Recall Date
To remove a record from the People to Call list, delete the Recall Date or enter a Recall Date that relates 
to a date in the future.



Importing Contacts
Deleting a Line

The Import Contacts screen provides you with a way of importing your existing contacts (Clients, 
Suppliers, etc.).    The basic idea is to copy and paste all the data from your other program into the import 
screen, and then press the Import button.    You do not have to have data in all the columns.

Before importing bulk data, you may want to do a test import with only one line of data.

The general procedure for importing contacts is as follows :-

1.    Prepare your Contacts Data    If your contacts data is not in a windows program where you can copy
and paste columns of data (such as Microsoft Excel), then you need to get it into one of those 
programs first.

2.    Copy the Company Data    From your contacts data, select the column containing the company 
name (by clicking on the button/box at the top of the column - see example below), and copy it to the 
clip board (from the Edit menu).

3.    Paste the Company Data    On the Import Contacts screen, click on the Company button/box in at 
the top of the top of the screen (See example below), and paste the company details in (paste from the
Edit menu).

4.    Copy and Paste the Other Columns    Copy and Paste the other columns in a similar manner to 
steps 2 and 3.

5.    Check and modify the data    Check the data, and modify it accordingly.
6.    Ready to Import    Once all the data has been checked, click on the Import button to import your 

Contact data.

Selecting a column



Mail Merge

You can export all the contact details to Excel for a mail merge as follows :-

Open the Mail Merge report in the Report Writer
Select the fields you want to export
Click on the Spread Sheet view
Select all the records (Edit Menu), and copy them to the clip board
Paste them from the clip board into Excel.



Setup Wizard

You can run the setup Wizard from the File Menu.

To view help on the Setup Wizard, please go to the screen in question and press F1 or Help.



Setup Wizard - Company Name and File Name

The Company Name will appear on the main screen and at the top of many reports.

Cashbook Complete allows you to run cashbook's for several companies.      Enter an eight character 
name which will be used for the file name.



Setup Wizard - Regional
Year 2000

If the country is incorrect, then it is strongly recommended that you exit the Cashbook and change the 
Regional Settings to the correct values before continuing.    To change the regional settings, click on Start,
Settings, Control Panel, Regional Settings.

Cashbook Complete is programmed to work differently for different countries, so it is important that you 
select your own Country (and State if applicable).

It is recommended that you set the date format to display four digit years by placing four y's in the date 
format.    For example    d/m/yyyy

There may be a discrepancy between the date format displayed here, and the date format displayed in 
the control panel.



Setup Wizard - General

1.    Organisation Name    This name will appear on your main screen, letterhead and many reports.
2.    Check Disk Space on Startup    To prevent the database from getting corrupted due to your hard 

disk getting full it is recommended that the hard disk space is checked when the software starts.
3.    Financial Year End Date    This date will be used to remind you to do your Year End reports.
4.    Backup Directory    This is the directory where Backups and Restores are done to or from.
5.    Paper Size    The default paper size for reports etc.
6.    Initial Screen    This is the screen displayed when the software starts.    It can be set to either None 

(So that you will only see the toolbar and menus), Main Screen (shows a main switch panel) or 
Cashbook (if you only use the Cashbook).

7.    Current Date / Time    For accounting software it is important that the date is correct.
8.    Customisation    This is normally set to Standard.    If you select Farming, then you will have an extra 

column in the cashbook which lets you enter a quantity.    The Advanced button lets you set up more 
advanced for screen formating.

9.    Email Address    Your own Email address.    This will be used as the Return Address when you send 
emails.

10. BankWeb Site    Enter your banks web site starting with www.



Setup Wizard - Modules / Features

This screen lets you select the level of functionality you require.

Edition
Cashbook Home is similar to MS Money or Quicken, and is only for home users who do not need GST to 
be calculated.    It is an excellent tool for doing your home budgets.    Cashbook Lite can do GST Returns, 
and also includes the Contact Manager.    Cashbook Complete also includes Invoices, Statements, 
Projects, Timesheets, Expenses and Quotes.

Security
This allows a logon with a password and different privileges for different users.    This is only available to 
registered users.

Report Writer
This gives you the power to create your own reports, ad hoc queries, etc. and lets you export data to 
other programs.        This is only available to registered users.



Cashbook - GST Setup Wizard

1.    Sales Tax Type    Select the most appropriate Sales Tax Type from the Combo box.
2.    Sales Tax Name    This is automatically entered when the Sales Tax Type is selected.    This name is 

used on many screens and reports.    It is usually set to either VAT, GST or TAX, but can be over-ridden
with a new name of up to 3 characters.

3.    Default GST Rate    This will be used as the default for Invoicing and Cashbook Categories which 
have GST.

4.    GST Number If you are GST registered then enter your GST number here.    This item's name can 
also be changed by clicking on More.

5.    Price Lists Include GST    If you generally sell to other companies then your prices would normally 
exclude GST (ie. select No), but if you generally sell to the general public then the prices would 
normally include GST    (ie. select Yes).

6.    GST Return Type (New Zealand Only)    This lets you select the GST method you have chosen with 
the IRD.    It is recommended to use Payments Basis (Cash Basis) because it is the easiest and by far 
the most common method for small businesses.



Cashbook - Bank Account Setup Wizard
Deleting an Account

All the bank accounts set up here must belong to the same organisation.    If you want to set up accounts 
for different organisations then each one should be put in its own cashbook by selecting New Cashbook 
from the File menu.

For the opening balance choose a bank statement from which you want to start entering the cashbook 
data.

The most often used bank account should be entered first.



Setup Wizard - Invoicing

1.    Default GST Rate    This will be used as the default for Invoicing.
2.    Invoice Header    This will be displayed at the top of the invoice.    Common headers are "Invoice", 

"Tax Invoice", "Invoice / Statement".
3.    User Defined Field Name    This is normally set to "Work Done For", but can be changed to 

something else specific to your business.
4.    Invoice Terms - Text    This is the initial value used on your Invoices for the Terms and is printed at 

the bottom of each invoice.    You can over-ride these default terms for specific invoices if you wish.
5.    Invoice Terms - Formula    This formula is used by Statements to calculate the due date.    It should 

have the same meaning as item 3.
6.    Next Invoice Number    This is the Invoice Number that will be given to the next invoice.    This 

counter is automatically incremented every time you generate a new invoice.
7.    GST Number    If you are GST Registered then enter your GST number here.    This item's name can 

also be changed by clicking on More.
8.    Display GST Number on Invoice    Do you want to display your GST number on your invoice ?
9.    Print Payment Slip on Invoice    Selecting Yes will print a payment slip on invoices.
10. Print Payment Slip on Statement    Selecting Yes will print a payment slip on statements.
11. Display Payments Made on Statement Selecting Yes will print the payments made so far for each 
Invoice.



Setup Wizard - Letterhead Name and Address

1.    Company Name    This name will appear on your main screen, letterhead and many reports.
2.    Address, Phone, Fax Mobile, etc.    Enter all your contact details that you want to appear on your 

letterhead for your invoices, statements, quotations, etc.



Setup Wizard - Security

With Cashbook Complete you can set up logon's with different security privileges (Access Rights) for 
different users.    It is possible to lock yourself out of the system if you forget your user name or password,
or if you do not give yourself the privileges to modify your own privileges !

In this screen please set up at least two users who will have full access to all the modules, and write their 
User Names and Passwords Down.    If you do not know what the passwords are then simply re-enter 
them.

You can set the privileges up in more detail from Employees & Security Setup under the Time & Cost 
menu.



Setup Wizard - Time and Cost / Quotes

1.    Invoices are often generated from Timesheets & Expenses    This is the default value of the 
Invoice column in the Timesheets and Expenses data entry screen.    You can generate Invoices 
directly from your Timesheets and Expenses.    If you think that you will do this for most of your 
invoices, then select Yes.

2.    Default User    The default user for entering Timesheets and Expenses (Only displayed if Security is 
turned Off)

3.    Full Name    Enter the employees first and last names
4.    User Name    The User name that will be used to log on (Only used if Security is selected)
5.    Password    The Password that will be used to log on (Only used if Security is selected)
6.    Cost Rate    Wages per hour plus about 20 % to allow for holidays, overheads, etc
7.    Charge Rate    Normal hourly charge out rate



Setup Wizard - Importing Data

You can Import data into Cashbook Complete by clicking on the Import buttons, or Import them later by 
selecting Import from the Cashbook or Contacts menu.



Setup Wizard - Setup Complete

Now that you have finished setting up the cashbook you can click on Finish to start using the cashbook.



Email Setup
Emailing Invoices and Statements

This is found under the Invoicing menu.

Return Email Address - Enter your own email address here.    If this email address is not valid, then 
emails will not get to their destination.    It seems that email servers do not pass on emails with an 
invalid return address.

Copy Invoice and Statement Emails To - If you want a copy of the emails that are sent out, then put 
your own email address here as well.

SMTP Server - If you have Outlook Express, click on Tools, Accounts, select the account (of type mail 
default), Properties, Servers Tab.    The "Outgoing-mail (SMTP)" text contains the data you need to 
put into SMTP Server.    If you have a different email program, you should be able to find the SMTP 
Server somewhere in the Setup.    If you can't find the SMTP server, then your ISP (Internet service 
provider) can tell you your SMTP Server.    As an example, if your ISP is yourisp.com, then the 
SMTP Server is usually something like smtp.yourisp.com

Invoice Email Footer Text - The text you place here will be placed at the end of every Invoice email you 
send out.    This text is sometimes called a signature.

Statement Email Footer Text - The text you place here will be placed at the end of every Statement 
email you send out.    This text is sometimes called a signature.

Example of Footer Text

CREDIT CARD PAYMENT OPTION:    Please debit my Visa / MasterCard    (circle one) for this invoice.

Card Number: ___ ___ ___ ___        ___ ___ ___ ___        ___ ___ ___ ___        ___ ___ ___ ___

Cardholder's Name: ______________________________________ Card Expiry Date:    ___ ___ / ___ 
___

Signature: _____________________________________________ Date: ___ / ___ / ___



Quick Keys

In many screens there are certain Quick Keys or "Keyboard Shortcuts" available (with corresponding 
buttons in the screen header) to help speed up regular tasks that you are likely to perform.    Pressing 
a Quick Key has the same effect as clicking on the corresponding button in the header section of the 
form.

F1 =  Help
F5 =  Lookup    Lookup a record for the current screen from a list.

F8 =  Delete        Delete the current record.

F9 =  New              Add a New record.

F10 =  Close Close the current screen.



Administration
Backups          Restore

The following Administrative functions are available from the File menu :-

1.    Backup Cashbook    The practice of keeping regular backups of your cashbook is strongly 
recommended. To help you do this, Cashbook Complete will remind you periodically, but you can also 
select Backup Cashbook from the File menu.

2.    Restore From Backup If you do need to do a Restore, select Restore from the File Menu.    It is 
recommended that you make another backup of your cashbook before restoring the old one (in case 
you change your mind, or the restored database is corrupt as well).

3.    Repair and Compact    If the database gives an error something like "The database is corrupt.    
Please Repair and Compact the Database", then select it from the File menu.    The database can 
become corrupt if for example the power goes off while you are entering some data.    When you select
this item, the Cashbook and Projects are recalculated as well.    It would be a good idea to Repair and 
Compact the Database about once a month.

4.    Purge    (Delete Old Data)    You can purge old data to reduce the size of your database, you can 
select it from the File Menu.    To recover the disk space after the purge, you need to run Repair and 
Compact as well.



Year 2000
License Agreement 

Acclaim Software Ltd warrants that this product will :-

1.    Accurately process date-related data after 31st December 1999
2.    Allow four digit years to be displayed wherever a date is displayed
3.    Correctly process leap years, including the year 2000

This warranty is subject to the terms and conditions stated in the License Agreement.

It is recommended that the software be configured to display a 4 digit year (Select Setup Wizard from the 
File menu).    All dates from the 1st January 2000 onwards will be displayed with four digit years 
regardless of whether the date format is two digits or four digits.



Deleting Line Items

Select "Delete Line" from the "Edit" menu or :-

1. Click on the grey box to the left hand side of the line you want to delete. (as shown in the example 
below)
2. Press the Delete key on your keyboard. (or select Edit, Delete from the menu at the top of the screen)



Placing an Icon on your Desk Top

If you are using Windows 95 and wish to place an Icon to start this software on your desk top, the 
procedure is as follows :-

1. Click on Start button with your right mouse button.
2. Click on Open
3. Double Click on the Programs folder
4. Double Click on the Cashbook Complete folder
5. Click on the Cashbook Complete Icon and then press Ctrl C to place the icon on the clipboard
6. Close all programs down, click somewhere on the desktop, and press Ctrl V to paste the icon onto the 
desk top.



Setup & Administration

Backup, Restore, Repair, Compact, Purge
Placing an Icon on your desk top
Setup - Cashbook
Setup - Letterhead
Setup - Network
Setup Wizard
Transfering To Another Machine
Year 2000



License Agreement

IMPORTANT :  Please read this License carefully before using the software.    The right to use this software is 
granted only if the customer agrees to the terms of this license.    If you do not agree to the terms of this License, you 
must not use the software, and must remove it from your computer.    However, use of this software indicates your 
complete and unconditional acceptance of these terms and conditions.    Acclaim Software Ltd grants you a 
license to use a copy of the software subject to the following terms and conditions.

1.    No title or ownership is conferred with this license.
2.    This license also applies to customised versions of the software.    For customised versions all intellectual rights 

remain with Acclaim Software.
3.    The Software may only be copied using the original installation disks or installation file.
4.    You do not remove any copyright notices from any part of this software.
5.    This software is copyrighted and may not be disassembled, de-compiled,    decrypted, or reverse engineered, or 

have its security tampered with.
6.    Any third party supplier of this software is a third party beneficiary of this license and may protect it's rights 

against violations in this license.
7.    Acclaim Software Ltd reserves the right to terminate this license upon breach.    In the event of termination of the 

License, all copies of the software must be returned or destroyed.
8.    Acclaim Software Ltd shall not be liable for lost profits, or for any incidental, special, or consequential damages 

caused by this software.
9.    You may not alter the software without the written consent of Acclaim Software Ltd.
10. This Agreement sets forth the entire agreement between the parties.
11. Acclaim will not be held liable to fix any problems caused by Microsoft's operating systems or their database 

products, printer drivers, faxing software, word processing software, internet browsers, connections to the 
internet, or any connections to other software.    You must have a reliable connection to the internet if you want to 
email invoices and statements.

12. Errors or omissions in the software will be fixed at Acclaims discretion.
13. Acclaim does not warrant or guarantee that the software will meet the licensee's requirements.    The Licensee 

must check that the software meets their requirements before purchasing the software.    No refunds are given.
14. Prices and Support arrangements shown by the software or help file are updated from time to time.    The latest 

information on prices and support are on our web site (found by clicking on the Help menu and selecting About).
15. The Home edition is free, but you must register business cashbooks once you have determined that the software 

is suitable for that business.    Each business cashbook database is to be registered separately.
16. Acclaim reserves the right to restrict the functionality of the software for unregistered users, or for users who have

not registered the software to the appropriate level.
17. Free support is currently provided for up to 3 incidents for each registered cashbook.    After the 3 incidents have 

been used up, extra support needs to be purchased.    Callouts to the customers premises, or problems which 
take more than 30 minutes to resolve are charged out at Acclaim's normal hourly rate.    Acclaim reserves the right
to change phone support to an 1900 / 0900 number at any time in the future.

18. Free support for unregistered users is given at Acclaims discretion.
19. Free support is not to be used as a substitute to training or reading the manual or help files.
20. Support is given only in the English language, and is not given to people who do not have a basic understanding 

of how to operate their computer.    Acclaim does not give support on how to download your bank statement from 
the internet because every bank is different.    For that you must contact your bank.

21. This License Agreement may change when the software is upgraded.    The Licensee must check and accept the 
new license agreement before upgrading.

22. Upgrading of customisations is charged at Acclaims normal hourly rate.
23. If there is a special promotion in a specific country, it is your responsibility to make sure that your Regional 

Settings in the Setup Wizard are set to your country, otherwise the special promotion will not apply.
24. Upgrades have been free, but Acclaim reserves the right to charge for upgrades in the future.
25. For GST Returns, VAT Returns and GST Calculation Sheets, the onus is on you to make sure the figures are 

correct.    There may be some scenarios which are not handled by these reports, in which case they should be 
calculated manually.



Networking

This software can be installed on a network, and can be used by more than one person at a time.    By 
having it on a File Server, you could also take advantage of its regular backup.    To install it on a 
network :-

1.    Install the software on each computer as though it is going to work locally.
2.    Copy the <<Company Name>>.CB file to a directory on your file server.
3.    Select Open Cashbook from the File menu, and enter the directory where the cashbook(s) resides.

Please note that :-

1.    If you have an unreliable network your datafile may become corrupted.
2.    The Windows NT backup system does not back up files which are in use, so it is important that all 

users exit the system when a backup is being done.



Suggestions

If you have suggestions to make for this product, please send an email to support@acclaimsoftware.com



Support

Our latest support system and prices are shown on our internet web site (found by clicking on the Help 
menu and selecting About).



Reports Contents

Cashbook
Contact Management
Report Writer Contents



Registration - New Zealand

Cashbook Lite
With Cashbook Lite, you will be registering the :-

Cashbook
Contacts
Bills to Pay
Report Writer

You will be able to use the whole program on a trial basis, but may be asked to upgrade to Cashbook 
Complete later on.

Cashbook Complete
With Cashbook Complete, you will get all the modules and functionality of the program.

Upgrade Lite to Complete
With the Upgrade you will convert Cashbook Lite to Cashbook Complete.

Installation CD ROM
With the CD ROM you will be able to install the software on PC's which are not connected to the Internet. 
The software may be freely copied to as many PC's as you wish, so long as the software is registered 
once it has been evaluated as being suitable.    The CD ROM version is identical to the Internet version.    
You can make a set of Installation Floppy Disks from the CD ROM.

Instruction Manual
The Instruction Manual gives you thorough instructions on using the software in printed form.    It can also 
be viewed online from the Help menu.



Registration - Australia

Cashbook Lite
With Cashbook Lite, you will be registering the :-

Cashbook
Contacts
Bills to Pay
Report Writer

You will be able to use the whole program on a trial basis, but may be asked to upgrade to Cashbook 
Complete later on.

Cashbook Complete
With Cashbook Complete, you will get all the modules and functionality of the program.

Upgrade Lite to Complete
With the Upgrade you will convert Cashbook Lite to Cashbook Complete.



Registration

Cashbook Lite
With Cashbook Lite, you will be registering the :-

Cashbook
Contacts
Bills to Pay
Report Writer

You will be able to use the whole program on a trial basis, but may be asked to upgrade to Cashbook 
Complete later on.

Cashbook Complete
With Cashbook Complete, you will get all the modules and functionality of the program.

Upgrade Lite to Complete
With the Upgrade you will convert Cashbook Lite to Cashbook Complete.



Backup
Restore          Repair and Compact            Transfering To Another Machine

Cashbook Complete automatically keeps backups of your data files in the C:\Cashbook\Backups 
directory.    These backups should not be used as a substitute for doing proper backups as shown below, 
because they won't help you if your hard disk fails, or your computer gets stolen.

Cashbook Complete will remind you periodically to do a backup, but you can also select Backup from the 
File menu.    When the backup screen appears, it will tell you when your cashbook was last backed up, 
allow you to specify how often you wish to be reminded to do backups, and specify the directory on which 
the backup should be stored.

Backup to Floppy Disk
Floppy disks are unfortunately only 90% to 99% reliable, so it is important to have more than one backup 
set.    You might for example have two sets of floppy disks, and alternate them, so that you always have a 
current and a past backup.    You might want to restore the data to another machine to make absolutely 
sure that the backup is OK.    For your security, backup files should be kept in a safe place away from your
computer. Warning :- All data on floppy disk(s) that you insert for the backup will be deleted.    If your 
backup spans more than one floppy disk the files will be named <filename>.001, <filename>.002 etc.    
These files can only be restored by using the Restore function of Cashbook Complete.    If you have any 
errors with the floppy disk itself, then throw it away and try another one.    Keep floppy disks away from 
heat, and magnetic fields.

Backup to a File Server
If you save your backup on a file server, your cashbook file will be copied directly.    Please make sure that
the server is regularly backed up.

Backup to CD-ROM
If you want to do a backup onto CD-ROM, then you only need to save the <Company Name>.CB files in 
the C:\Cashbook directory.    All the cashbook information including the registration information is stored in
those files.    If you cant see any .CB files, then you probably have the viewing of file extensions turned off,
and you will need to turn them on.

Backups should be kept away from your computer, so that if there is a fire, flood, or the computer is 
stolen, your backups are still safe.

Please note that the Word/Wordpad files created by the Quotes module are not backed up by this 
procedure, and need to be backed up separately if they are important documents.



Restore from Backup
Backup          Repair and Compact            Corrupt Database          Floppy Disk Errors          Transfering To 
Another Machine

If you are a computer novice, it is recommended that you get someone with some computer experience to
help you, because you can really mess things up by copying older files over newer files, etc.

If you have already registered the software (when the backup was done), there will not be any need to 
enter in the registration code again, because it is transfered with the data file.    After restoring your data 
file, you can check that you have the registered version in the About screen.

In the text below <YourFileName>.CB is used to represent the name of your file (eg.    MyData.CB).

Restore from Floppy Disk
Simply put the floppy disk into the A: drive, make sure that the Restore Directory is A:\ and press the 
restore button.    If you have an error reading from the floppy disk then go here.

Restore From Another Location
Simply copy the <YourFileName>.CB file back to the C:\Cashbook folder from where it was saved to.

Restore From CD-ROM
Simply copy the <YourFileName>.CB file back to the C:\Cashbook folder from the CD-ROM.    Then right 
click on the file in the C:\Cashbook folder, select Properties, and make sure that Read-Only is Unchecked.

Restore From Automated Backup
Cashbook Complete does automatic backups to the C:\Cashbook\Backups directory.    Files with the .bk1 
are the most recent, and files with .bk3 are the oldest.    Look at the dates of these files to see how far 
back you want to go.    Rename the <YourFileName>.CB in the C:\Cashbook directory to say 
<YourFileName>.BAK.    Then copy the file you want, back to the C:\Cashbook folder, and rename it to 
<YourFileName>.CB.

Restore From OLD File
If you dont have any of the above, you may have a <YourFileName>.OLD file in the C:\Cashbook folder.    
Simply rename the <YourFileName>.CB to say <YourFileName>.BAK and then rename the 
<YourFileName>.OLD to <YourFileName>.CB.



Restore from Floppy Disk Errors
Backup          Repair and Compact            Corrupt Database

If you get the error "Device I/O Error" or "Device Unavailable" then Windows is having difficulty reading 
the Floppy Disk.    You can try the following to recover your data.    These steps should be done by 
someone with a reasonable amount of computer experience.

Try Copying the Disk Manually - If the file is a .CB file then you could try copying it manually to the C:\
Cashbook folder.      If the file is a .001, or .002, etc file then try copying all the files to the C:\Cashbook 
folder, and then restore from those files by clicking on File, Restore From Backup, Browse, Multiple 
Floppy Disks, and select the first (.001) file.

Try a Different Backup - If you have another backup, then try that.

Try a Floppy Disk Head Cleaner - You can buy Floppy Disk head cleaners from computer accessory 
shops.

Try Restoring to a Different Computer - Install the cashbook on a different computer (eg. a friend, or at 
work) and try restoring to that.    Sometimes for one reason or another one computer can read the disk 
when another can't.    If you succeed, then make a backup from that computer to a different set of disks, 
and restore from those.

Try a Data Recovery Specialist - There are companies that specialise in data recovery such as 
http://www.datarecovery.co.nz

If none of the above have worked then you could try the following, but the changes made to the floppy 
disk are irreversible.

Try Norton Utilities - Norton Utilities may be able to repair the floppy disk.

Try ScanDisk - You can run ScanDisk on the floppy disk by clicking on Start, Programs, Accessories, 
System Tools, ScanDisk.    Then select A:, Thorough, Automatically Fix Errors, and press Start.



Corrupt Database

A cashbook database can get corrupt by any of the following reasons :-

1.    The computer is turned off, rebooted or crashes while you are in the cashbook.    ScanDisk is left to 
pick up the pieces of files that are not saved properly.

2.    The cashbook is being used across a network, and the network connection is broken.    If you are 
getting network errors, it is important to get them fixed so that you don't get corrupted cashbooks.

3.    The Hard Drive is not working correctly.    Try running a ScanDisk (Click on Start, Programs, 
Accessories, System Tools, ScanDisk)

4.    There is a Virus on the computer.    Run a recent virus checker to make sure that there are not any 
viruses on your computer.

If you have a corrupted database, then select "Repair and Compact" from the File menu.    If that doesn't 
fix it then Restore from your Backup.    If you don't have a backup, then contact Acclaim Software.



Transfering to Another Machine
Backup          Restore

First you need to install the program on the new machine.    You can make a set of four floppy disks from 
your old machine, and use them to install the software on the new machine.      You could alternatively 
download the program of the internet onto your new computer and install it.

There are several ways of transfering the cashbook to another machine.    All the data is stored in a file 
called <Your Company Name>.CB      (eg.    DAVIDST.CB, or LONGDRAP.CB, etc) and resides in the C:\
Cashbook folder.    All you need to do is to somehow get that file into the C:\Cashbook folder in your new 
computer.    You could either :-

1.    Do a Backup to floppy disk on the old computer and a Restore From Backup on the new computer.
2.    Manually copy the file to floppy disk, and manually copy it from the floppy disk to the new computer.
3.    Email the datafile to your new computer.
4.    Use a CD Writer or Zip Drive

If you are a computer novice, then you may need to get someone to help you.

If the cashbook file is registered on the old computer, then it will automatically be registered on the new 
computer, because the registration information is stored in the data file.

If you have Quote documents on your old computer, you will need to transfer those as well using methods
2, 3 or 4.    They will be in your C:\Cashbook\Letters\<Your Company Name>    folder.



Errors

Copy the error message to the clipboard (hold Ctrl key down and then press C) and paste it as a 
message in an email (hold Ctrl key down and then press V) addressed to support@acclaimsoftware.com

If you got a Runtime Error, please email us exactly what you were doing, the screen you were in, the data 
you typed in, etc.

This will help us to improve Cashbook Complete for the next time you upgrade.



Searching for Data

There are several ways of finding data :-

1.    Find    You can select Find from the Edit menu (or press Ctrl F) to do a search in the cashbook.
2.    Sort A - Z    You can sort a column in alphabetical order by selecting it from the Edit menu.
3.    Moving or resizing columns    You can resize a column by moving the mouse over the column header 

edge and then dragging it to the requred width.    You can change the column order by clicking on the 
column header and then dragging it to the new position.

4.    Report Writer    The report writer is a powerfull querying tool which will let you use wild cards (* or ?) 
and other criteria to find the information you want.



Date Format

It is important to that you have the correct Regional and Date Format settings on your computer.    For 
example in the United States, dates are entered as Month/Day/Year, but a lot of other countries use 
Day/Month/Year.

To check your settings click on Start, Settings, Control Panel, Regional Settings (or if you have Windows 
XP, click on Start, Control Panel, Date Time Language and Regional Options, Change the Format of 
Numbers Dates and Times).    Check that you have the correct country selected.    Click on the Date tab 
(or if you have Windows XP, click on Customize, and then the Date tab) and check that you have the 
correct Short Date Style setting.    Common Short Date Styles are :-

Australia - d/MM/yyyy
Canada - dd/MM/yyyy
Ireland - dd/MM/yyyy
New Zealand - d/MM/yyyy
South Africa - yyyy/MM/dd
United Kingdom - dd/MM/yyyy
United States - M/d/yyyy

For new settings to take effect, please exit and restart the cashbook.



Faxing

To fax reports, invoices or statements to someone else using your computer, you need to have a fax 
modem and faxing software (such as WinFax Pro) installed.    The faxing software will configure itself as a
printer.    To fax something from the cashook, you simply Preview the report, select Print from the File 
menu, select Setup, select the Fax (printer), press OK, and the next OK.    The faxing software will then 
ask for the fax number, and the fax will be sent.

For Invoices, Statements and Quotes it is probably better to email them.



Frequently Asked Questions (FAQ)

The Frequently Asked Questions are divided into the following categories :-

New Users
Registration
Problems
Other



FAQ - New Users
Registration          Problems          Other

Can I send the cashbook to my accountant ?      Yes, you can email your data file to your accountant 
(or post it on a floppy disk).    Your accountant will need to install the cashbook (free download from the 
web) to view your data.

Can I import into MYOB, Solution 6 or CA Systems ?      No, we don't have any facility for that yet.

Can I import my data from another program ?      The cashbook can import customer (more...) and 
product (more...) data from a spreadsheet, so if you can get the other programs data into a spreadsheet, 
then you can.    The cashbook can also import QIF files from Quicken and MS Money or any other 
program that exports a QIF file.    more...

Can I import bank statements ?      Yes you can.    The imported data will be merged with the data that is 
already in the cashbook.    more...

Can I email invoices, statements and quotes ?      Yes, with version 4.0 onwards you can.    more...

How do I fax my reports ?      You first need to install faxing software.    more...

How do I find out what version I have ?      The current version is in the About screen and Support 
screen.

Do I have to pay for updates ?      At the time of writing updates are free off the internet.

If I upgrade, will I lose my data ?      No.    Your data file will be upgraded to the latest version and your 
data will remain intact.

How much support do I get ?      You get three free support calls / emails, and after that it is at our 
discretion, so don't use your free support for trivial questions which are covered in help.    If you want 
more support, it costs $50 for another three calls / emails.

Why is your program so cheap ?      We are going for the mass market, and are going for high volume 
rather than high price.

Why is your program so expensive ?      Compared to other accounting software, it actually isn't 
expensive.      After using the program for free for a few months, maybe it does feel expensive.

What is the difference between your program and MYOB ?        MYOB is more comprehensive and 
has all the bells and whistles, but is also a lot more difficult to use (in our opinion).    Some of our 
customers have come from MYOB and find our software refreshingly simple and easy to use.    Others 
have converted over to MYOB because they want the bells and whistles, and have the appropriate 
training to use it.

Can I customise the software ?      You can customise your letterhead setup, and can configure your 
own reports, but cannot customise it beyond that.

Does it run on a Mac ?      If you install Virtual PC, you can run it on a Mac.    We don't have Mac's so we 
don't provide support for this configuration, but our users have told us that it works fine.

Can Cashbook Complete do wages ?      No, sorry, it can't.    You can print out timesheets on a weekly or
monthy basis so that you can see the number of hours that your employees have worked.

Can I back up to a CD Writer ?      Yes you can, but you need to use the CD-Writer software to do it.      



more...

How do I view or check my backup ?      If the cashbook data file fits on one disk, then you can double 
click on it, or else open it from within the cashbook.    If it spans multiple floppy disks, you need to restore 
it onto another computer.

Does it do stock control ?      Yes it does.

I need a report to . . .      Cashbook Complete lets you configure your own reports with the Report Writer.   
more...

Can you email me the program ?      There are several web sites you can download it from.    They are    
www.acclaimsoftware.com,    www.cashbookcomplete.com,    www.acclaimsoftware.com.au    and    
www.acclaim.co.nz



FAQ - Registration
New Users          Problems          Other

Do I need to register again if I run it on two computers ?      The registration is on a per data file basis, 
not on a per computer basis.    If you use the same data file on two computers (either by moving it from 
one computer to another, or by networking the computers), then you don't need to pay any extra.    If you 
create a new cashbook data file (for another organisation), then you do.

I've registered, but the registration reminder is popping up      You either haven't typed in the 
registration code we sent you, or else have created a new data file which is unregistered.    Registration is 
on a per data file basis.    It could also be because you registered Cashbook Lite, but are using the 
features of Cashbook Complete.

When I register will I keep my data, or do I have to start again ?      You can carry on with the data you 
have already entered.

If it times out (expires) after the free trial, will I lose my data ?      No you won't lose your data, but you
won't be able to access it until you have registered, and the registration code is typed in.

I've changed my company name, and now I need a new code    You don't need a new code.    You can 
change your organisation name in the Setup Wizard and the software will remain registered.    If you set 
up a new data file, it will need to be registered separately.

Why do I have to pay for another data file ?      That is the way our registration works.    The registration 
information is stored in the data file, so you can move it around and it will remain registered.    If you make
a new file for a new business, then that file needs to be registered separately.

My Unlock code doesn't work      Make sure that the Organisation Name in the Setup Wizard is the 
same as the organisation name that you registered.    If it is, and the code still does not work, then contact
us.

I've ordered but haven't received an email      This can happen if the email address you give us is 
incorrect.    If you haven't received it in 24 hours, then please contact us.

If I Register and then change my mind, can I get a refund ?      We give a generous trial period (90 
days), but once you decide to buy, there is no refund.



FAQ - Problems
New Users          Registration          Other

I get an error when doing a restore from backup      This is covered extensively here

I get an error when doing a backup      If you have an unreliable floppy disk it is best to throw it out.    
more...

My envelopes don't print properly      Unfortunately only about 80% of printers print envelopes correctly. 
The cashbook prints the name and address in the center of a DL envelope.    If your printer doesn't print it 
out correctly, then there isn't a lot we can do.    You could try window envelopes for Invoices and 
Statements.

Why does the cashbook sometimes freeze with Windows ME      There is a bug in Windows ME.    It 
looks as though it is something to do with low power shutdown, or the screen saver, because it only 
happens when Windows ME has been idle for a long period.    We have notified Microsoft but it does not 
look as though they will release a service pack to correct the problem.

My Repair and Compact fails      You probably have a corrupted database from a disorderly exit from the 
cashbook.    more...

The program is slow to load      Some programs interfere with the cashbook.    Make sure that you don't 
have Webhancer or whAgent.exe installed.

The GST Return (for New Zealand only) isn't showing any sales      If you are on Invoice Basis GST, 
then the income is derived from your invoices, not your cashbook.    It is recommended to use Payments 
Basis GST (see the Setup Wizard).    more...

My cashbook is giving me an error which wasn't there before      Try running Repair and Compact 
from the File menu.    If that doesn't fix it then try reinstalling the software, by running Setup.exe in the C:\
Cashbook\Disk1 folder.

Tick boxes are circles      Some TNT video cards don't display tick boxes correctly, so the cashbook uses
radio buttons instead.    You can change it back again by going to the Setup Wizard, General Setup, 
Advanced page.

I've set up a new data file and my old one has gone      It may look as though it has gone, but it hasn't.   
Cashbook automatically re-opens the last cashbook you had open.    To go back to the first one, select it 
using Open Cashbook under the File menu.

I get the error "A run-time error occured in module: . . .    You don't have permission to view this 
module"      Please select Repair and Compact from the File menu.    If that doesn't fix it then try 
reinstalling the software, by running Setup.exe in the C:\Cashbook\Disk1 folder.

I downloaded the upgrade, but it is still the old version    You probably forgot to run the upgrade file.    
You need to download it and then install (double click) it.



FAQ - Other
New Users          Registration          Problems

How do I transfer the cashbook to another machine    This is covered here

My computer has died, and I need a new unlock code    If you restore from backup onto your new 
computer it will automatically be registered.

Can someone give me some training    If there is a local dealer, you could ask them.

I've sent 5 emails in the last five minutes and haven't heard back    We only clear our email boxes 
once or twice a day.

Can I email my contacts from the cashbook    Yes, you can by double clicking on their email address in 
the Contacts screen.

Can it do a Purchase Order    No, sorry, we don't have Purchase Orders.

What do I need to do to become a dealer    You need to have a reasonably good knowledge of the 
cashbook, and need to be a registered user already.    For more information please contact us.

Can I Send an Invoice as an Attachment    We found that people don’t like receiving attachments 
because either they don’t have the software to open it, or else there is a risk of getting a virus.    Our 
Invoices and Statements are sent in HTML and can be viewed directly in the email program.



What's New in Version 4.0

In upgrading to version 4.0 you will now be able to use the cashbook with the internet.

Electronic Bank Reconciliation

If you have access to Online Banking (and can export a QIF file), then you will now be able to import your 
bank statements off the internet.    The Bank Reconciliation will be done automatically, and all you would 
need to do is make sure that the closing bank balance is correct.    The cashbook now puts all un-
reconciled transactions at the bottom of the screen.

Email Invoicing and Statements

You will now be able to Email your Invoices and Statements.

Quotes

The Quotation module has been upgraded.    It now has column options just like the invoicing module.    
You can also edit the default layout of your quote document and include items such as your letterhead, 
standard terms, etc.

Statements

Statements can now handle credits which don't have to be assigned to an Invoice.

Products and Services

There is now a Stock Received screen, and an Importing screen, and there are some new columns for On
Order, Min Level, and Supplier.

Splits in Bills to Pay

You can now have a split in the Bills to Pay screen.

New Reports

There is now a 'Balance Sheet' report and a 'Profit and Loss' report.




